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1 Breeze Kiosk

Overview

Breeze Kiosk is software to provide a touchscreen screen interface to allow users to view JPEG
images, animated GIF images and MP4 videos and select them for printing, emailing, texting or
uploading to their Twitter feed. It is designed to be used as a touchscreen kiosk and work with event
software such as Breeze Systems' photo booth software.

Breeze Kiosk can display a slideshow of the photos when not in use. It can also be used to display a
slideshow of photos from a photo booth on second monitor connected to the main photo booth
computer.

An interactive hashtag print station can be created by using Breeze Kiosk with Hotfolder Prints.
Hotfolder Prints provides tools to monitor a hashtag on Instagram or Twitter and automatically
download the photos to the PC and format them ready for display on Breeze Kiosk.
Please note: Hotfolder Prints is a separate product which needs to be purchased separately.

System Requirements

Breeze Kiosk is designed to run on a computer or tablet with a touchscreen display and running a
desktop version of Windows.

Operating Systems
It will run on the following desktop versions of Windows: Windows 10, Windows 8/8.1 or Windows 7
Please note: Breeze Kiosk only runs on desktop versions of Windows and cannot be used on tablets
running Windows RT or on phones running Windows Phone

Processor and RAM requirements
Breeze Kiosk will run on low powered tablets such as the HP Stream 7" tablet, Asus Transformer
Book, Lenovo Flex etc.
It will run on computers with Intel Atom and Celeron processors e.g. Atom Z3775 1.46GHz, Atom
Z3735G 1.33GHz, Celeron N2807 1.58GHz
Breeze Kiosk will also run on computers with more powerful processors such as Intel i3, i5 and i7 and
AMD processors.
The minimum RAM requirement is 1GB. The amount of RAM available may limit the number of photos
that can be held in memory which could cause Breeze Kiosk to run slowly. If this is a problem please
adjust the size of the image cache.

Warning: Some tablet PCs have a Windows button on the bezel around the screen. This button needs
to be covered with tape or the frame holding the tablet to prevent users from accessing it. Pressing this

http://www.breezesys.com/Photobooth/index.htm
http://www.breezesys.com/Hotfolder/index.htm
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button will cause the computer to display the Windows 8 start screen or Windows 10 menu and allow
users to break out of full screen kiosk mode.

Suggested Computers

Breeze Kiosk does not need a powerful PC to run and can be used on low powered tablets such as the
Microsoft Surface Go (Windows 10 not 10 S), Asus Transformer Book, Lenovo Miix 10, HP Stream
and Toshiba Encore. It can also be used on more powerful tablets such as the Microsoft Surface Pro
or convertible PCs such as the Asus Transformer Book Flip series computers, HP x360 series
computers, Lenovo Yoga series computers. The only important requirements are that the computer is
running a desktop version of Windows (e.g. Windows 10, Windows 8 or Windows 7) and has a
touchscreen.

There are also many Windows tablets available ranging from low cost 7" tablets to more expensive
tablets with larger screens such as the Microsoft Surface Pro. The 7" tablets with Intel Atom
processors are powerful enough to run Breeze Kiosk with up to 500 photos, however, many of them
have plastic screens which are easily scratched and may not be suitable for use at an event.

2 Installing, Registering and Activating Breeze Kiosk

After purchasing a license for Breeze Kiosk you need to register and activate the software on your PC.
Activating the software is a quick and simple procedure if the PC has access to the internet, however,
we recommend activating the PC at least 48 hours before an event. You can still activate a computer
which does not have access to the internet, but this involves sending an email to sales@breezesys.
com and will take longer than activating the software online. Each license can be activated on two
computers, providing only one computer is used at once.

You must deactivate the software before making any hardware changes, upgrading or repairing
the PC, reinstalling Windows or reformatting a hard disk. The software can then be reactivated after
the work has been done.

Topics covered in this section:
· Installing the software
· Uninstalling the software
· Evaluating the software
· Registering
· Activating
· Deactivating
· Moving the software to a different PC
· Making changes to your PC
· Decommissioning a PC
· Checking for updates
· Activation problems

Installing the software

The latest version of Breeze Kiosk can be downloaded from www.breezesys.com.

To install Breeze Kiosk simply download and run the setup program then follow the on-screen
instructions.

mailto:sales@breezesys.com
mailto:sales@breezesys.com
http://www.breezesys.com/BreezeKiosk/index.htm
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Uninstalling the software

Breeze Kiosk can be uninstalled using the standard Windows "Uninstall a program" option in the
Programs section of the Windows Control Panel.
IMPORTANT: Please deactivate Breeze Kiosk before uninstalling otherwise you may not be able to
activate the software on another computer. If you forget to deactivate the software you should be able
to reinstall the software, deactivate it and then uninstall.

Evaluation Version

The trial evaluation version of the software is identical to the registered version and is fully functional
for 15 days. Each time you run the software it will display the registration dialog allowing you to enter a
registration code or press the "Evaluate" button to continue evaluating the software:

At the end of the 15 day trial period you must purchase a license to continue using the software.

Registering the software

To purchase a license for Breeze Kiosk please visit our website: http://www.breezesys.com/
purchase_kiosk.htm. You will be sent an email containing your registration details when your payment
has been received.

To register Breeze Kiosk run the application enter your registration name and code exactly as they
appear in your registration email. You may find it easier to copy and paste both the registration name
and code directly from your registration email to avoid mistakes when entering it. Please keep a copy
of your registration email safe in case you need to re-enter your registration details.

http://www.breezesys.com/purchase_kiosk.htm
http://www.breezesys.com/purchase_kiosk.htm
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Click on the "Register" button after entering your name and registration details. If the details are
correct the message below will be displayed. An error message will be displayed if the name and
registration code are not valid (e.g. they were not entered correctly) or if you need to purchase an
upgrade to use this version of the software.

Click on the "Yes" button to register the software and the following message will be displayed asking
you whether you want to activate the software on this computer:

Click on the "Yes" button to activate the software on this computer (see the section below for details).

Activating the software

The software must be activated on the computer before it can be used. The software can be run
without activating for up to 10 days after the the date when the registration code was issued. After that
time the software will not run unless it is activated. Each license can be activated on two computers,
providing only one computer is used at once. If you wish to move the software to a different computer
you must deactivate it from the old computer before activating it on the new computer. Once the
software has been activated on a computer you can run it normally.

To activate the software click on the "Activate..." button in the registration dialog
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and the activation dialog below will be displayed:

The quickest and simplest way to activate the software is to do it online by pressing the "Activate
Online" button. Please note that the computer must have an internet connection and the program must
be allowed to access the internet in order to activate the software online.
Please note that it may take up to 30 seconds to activate the software online.

If the computer is not connected to the internet you can activate the software by email by clicking on
"Activate by email" button and the dialog below will be displayed:
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It is important that you copy all of the text and email it to sales@breezesys.com. Please do not modify
the text otherwise we may not be able to validate it. The simplest way to copy the text is to press the
"Copy text to clipboard" button and then paste it into the email by typing Ctrl+V. If the computer doesn't
have email you can copy the activation text to a USB memory stick and then read it on a computer
which does have email.

You should normally receive an email containing your activation code within 12 hours of sending the
activation request email. Paste your activation code into the "Activation code" text area at the bottom of
the activation dialog and click on the "Activate" button to activate the software. If you have closed the
activation dialog you can display it again by running the software and then clicking on the "Activate..."
button in the registration dialog followed by the "Activate by email" button.

Deactivating the software

The software can only be activated on up to two computers at any given time. If you wish to move the
software to a different computer you must deactivate it from the old computer before activating it on
the new computer.

You also need to deactivate the software before making any hardware changes, upgrading or
repairing the PC, reinstalling Windows or reformatting a hard disk. The software can then be
reactivated after the work has been done.

To deactivate the software select "Register..." from the Help menu in the main window to display the
registration dialog:

Then click on the "Deactivate..." button to display the deactivation dialog:

The quickest and simplest way to deactivate the software is to do it online by pressing the "Deactivate
Online" button. Please note that the computer must have an internet connection and the program must
be allowed to access the internet in order to deactivate the software online.

mailto:sales@breezesys.com.
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Please note that it may take up to 30 seconds to deactivate the software online.

If the computer is not connected to the internet you can deactivate the software by email by clicking on
"Deactivate by email" button and the warning dialog below will be displayed:

Click on the "Yes" button if you want to continue and the deactivation dialog below will be displayed:

It is important that you copy all of the text and email it to sales@breezesys.com. Please do not modify
the text otherwise we may not be able to validate it. The simplest way to copy the text is to press the
"Copy text to clipboard" button and then paste it into the email by typing Ctrl+V. If the computer doesn't
have email you can copy the text to a USB memory stick and then read it on a computer which does
have email.

You should normally receive an email acknowledging the deactivation code within 12 hours of sending
the request email. If you forget to copy the deactivation information and email it to sales@breezesys.
com you can display it again by selecting "Register..." from the Help menu in the main window and
clicking on the "Display" button. Please note that the copy of the deactivation information will be not be
available after another registration code has been entered.

Moving the software to a different PC

The software can be activated on up to two computers at any given time and so if you are moving the
software to a different PC you should deactivate the software from the old PC first. Then install the
software on the new PC, then register and activate the software.
If you are planning to move the software to a different PC permanently please following the instructions
for decommissioning a PC.

mailto:sales@breezesys.com.
mailto:sales@breezesys.com
mailto:sales@breezesys.com
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Making changes to your PC

You need to deactivate the software before making changes to your PC such as upgrading the PC
hardware, reformatting a hard disk, reinstalling Windows, upgrading Windows or getting a PC
repaired.
Simply deactivate the software online (or by email if the PC doesn't have access to the internet), make
the changes and then re-activate the software. If Windows has been reinstalled or the hard disk has
been replaced or reformatted you may need to re-install Breeze Kiosk, re-enter your name and
registration code and then activate the software.
The latest release and previous releases of the software can be downloaded from the upgrades page
on the Breeze Systems website.
IMPORTANT: Please make sure you have a copy of your name and registration code before making
changes to your PC just in case you need to re-enter them later

Decommissioning a PC

If you are decommissioning a PC and planning to sell it or give it to somebody else you need to 
deactivate the software and remove your registration details. It is very important that you remove your
registration details even if you have uninstalled the software otherwise the new owner may be able to
reinstall the software and gain access to your registration details. If someone obtains your registration
details they will be able to register and activate the software on their computer and could prevent you
from using it on your computer.

After deactivating the software you can remove your registration details by entering the special
registration code below:

Name: Uninstall
Code: 000JJ3-ECU7D3-QH1PYZ-XJQQPW-7YJ7KT-UTJ7FA-7AUPQX

This will install a special old code which replaces your registration details and will cause the software to
display an "Upgrade required" message when it is run.

If you decide to use the computer again you can reinstall the software, enter your registration details
and activate software.

Checking for updates

You can check for updates by selecting "Check for updates online". This will connect to the internet
and display details of the latest version Breeze Kiosk in your web browser. Alternatively go to the
Breeze Kiosk page on our website: http://www.breezesys.com/BreezeKiosk

Activation problems

If the error message "The server name or address could not be resolved" is displayed when you try to
activate or deactivate the software online it means that the PC is unable to access the internet. Please
check that that the computer is connected to the internet and check your firewall settings to make sure
that BreezeKiosk.exe (the Breeze Kiosk program) is allowed to access the internet. If you are still
unable to activate the software online you may need to activate it by email instead.

http://www.breezesys.com/upgrades.htm#DslrRemotePro
http://www.breezesys.com/upgrades.htm#DslrRemotePro
http://www.breezesys.com/BreezeKiosk
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If a different error message is displayed please follow the instructions displayed in the error message.
If you are not sure what to do please email sales@breezesys.com and include your registration name
and code and details of the error message.

Please also see the support page on the Breeze Systems website for help with activation problems.

3 Running Breeze Kiosk

Breeze Kiosk can be run by double clicking on the Breeze Kiosk desktop icon. When Breeze Kiosk is
run the main windows is displayed:

The window shows the folder it will monitor for new images, the folder where it will look for optional
screen images and what options have been selected.

Click on the "Start" button to run Breeze Kiosk in full screen mode or click on the "Settings..." button to 
adjust the settings.

In Operation

Press the "Start" button to run Breeze Kiosk and it will fill the screen with thumbnails displayed on the
left hand side, the currently selected image in the main area of the screen and icons for emailing,
printing or uploading images to Twitter:

The full screen kiosk display will display thumbnails for all the images and videos in the folder being
monitored. The display will be updated to include new images and videos when they are added to the
folder being monitored e.g. if it is monitoring the output from a photo booth the display will

mailto:sales@breezesys.com
http://www.breezesys.com/support_activation.htm
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automatically be updated as new photos are taken in the photo booth.

Photos and videos can be selected in a number of different ways:
1) Touching the thumbnail of the image to be displayed
2) Tapping to the left or right of the main photo to display the next or previous image
3) Flicking the main photo to the left to display the next photo or to the right to display the previous
photo

The thumbnail display can be scrolled by tapping above or below the scrollbar, by holding the scrollbar
and dragging it to a new position or by dragging the thumbnails up or down. 

JPEG images can be printed by tapping the printer icon. This will display a preview screen asking the
user to confirm whether the photo should be printed. Tapping print will print the image and then return
to the main display. Tapping cancel will return to the main display without printing the photo. Please
note that the default action when tapping the print icon for an animated GIF or video is to display an
error message saying it can't be printed.

Images and videos can be emailed by tapping the email icon. A touchscreen keyboard will be
displayed asking the user to enter their email address. Tapping the "Send email" button will send the
email after checking that the email address has the right format (e.g. name@domain.com). An error
message will be displayed if the email message doesn't have a valid format. Tapping cancel will return
to the main display without sending the email.

An SMS message can be sent via email by tapping the SMS icon. A touchscreen keyboard will be
displayed asking the user to enter their cellphone number. Tapping the "Send SMS" button will send
an email to your email to SMS provider who will then send an SMS message to the user's cellphone.
Tapping cancel will return to the main display without sending the SMS.
Please note: Sending an SMS message to a cellphone only sends a short text message and does not
send the photo. The text message could be used to send the URL of the photo so that the user can
view it on your website after it has been uploaded to the website.

An MMS message can be sent by tapping the MMS icon. A touchscreen keyboard will be displayed
asking the user to enter their cellphone number. Tapping the "Send MMS" button will will then send an
MMS or SMS message to the user's cellphone. Tapping cancel will return to the main display without
sending the MMS.
Please note: To send MMS messages you need a Twilio account (www.twilio.com). Twilio can only
send MMS messages to cellphones in the US and Canada. In other countries an SMS message with a
link to the photo will be sent instead. The link to the photo will be valid for 7 days. Please visit the Twilio
website to open an account and to check their charges for sending MMS and SMS messages.

mailto:name@domain.com).
http://www.twilio.com
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Images and videos can be uploaded to the user's Twitter feed by clicking on the Twitter icon. A
touchscreen keyboard will be displayed asking the user to enter their Twitter username and password.
Tapping on the "Upload Photo" button will display a web browser window showing the Twitter login
page. The user must tap on the login button to login to their Twitter account and authorise the
PhotoboothUploader app to access their Twitter account.
Important: Breeze Kiosk does not keep any record of the user's Twitter username or password

If the slideshow option is enabled the display and the kiosk has not been used for the preset time a
slideshow of the images and videos will be displayed. Tap the screen to exit the slideshow and return
to the main display.

Exit the slideshow by tapping the bottom right corner of the display twice. If the password protection
option has been selected a touchscreen keyboard will be displayed asking the user to enter the
password. If the correct password is entered the full screen display will close and the main window will
be displayed. An error message will be displayed if an incorrect password is entered.
You can also exit full screen mode by pressing the escape key on the keyboard.

Please see the preferences section for information on how to setup the various options.

Thumbnail Grid Display Option

The thumbnail grid display option displays the thumbnails in a grid layout to make it easier to find
photos when a large number of photos are available:

When the user touches a thumbnail it zooms to a full screen preview with icons displayed below for
printing and sharing. The full screen preview will close automatically after a timeout or when the user
clicks on the close icon in the top right hand corner of the display.

Running Breeze Kiosk on "High DPI" computers

Some modern laptops and tablet computers can have very high DPI screens which can cause
problems and confusion when running Breeze Kiosk v1.1 or later. If an application does not declare
itself as high DPI aware Windows will scale its output and make it larger so that it is readable on a high
DPI screen. This can result in text looking blurry and screen images being a different size than
expected e.g. a laptop with 13" screen with a resolution of 1920x1080 pixels may scale the screen to
1280x720 pixels when displaying the output an application that is not high DPI aware.

Breeze Kiosk v1.1 onwards runs as a high DPI aware application by default and should give sharp text,
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but you may that screen images created using previous versions of Breeze Kiosk no longer fill the
screen. This is because the previous release was not high DPI aware and so Windows scaled the
screen images. If this is a problem you can disable the high DPI aware setting by setting the following
Windows registry DWORD value to 1 and then restarting Breeze Kiosk:
HKEY_CURRENT_USER\Software\BreezeSystems\BreezeKiosk\100\DisableHighDPI

Saving Settings for Future Reference

The settings can be saved to file for future reference by selecting File->Save settings... and loaded by
selecting File->Load settings...

You can also load settings from file at startup by dragging and dropping a settings file onto the Breeze
Kiosk desktop shortcut or by right clicking on the Breeze Kiosk desktop shortcut, selecting properties
and adding the pathname to settings file to the "Target" (or command line).

Hiding the Windows Task Bar

On some systems the Windows task bar can appear at the bottom of the screen when Breeze Kiosk is
running in full screen mode. The Windows task bar can be hidden by running the Hide Windows
Taskbar utility which automatically hides the Windows taskbar when Breeze Kiosk is running in full
screen mode and restores the taskbar when you exit full screen mode. To run the Hide Windows
Taskbar utility simply double click on the HideWindowsTaskBar.exe icon in the Breeze Kiosk
installation folder (usually C:\Program Files (x86)\BreezeSys\BreezeKiosk).

Disabling right click on Windows 7 computers

The default setting some touchscreen PCs is for "press and hold" to generate a mouse right click. This
can look untidy and may confuse users if they tap and hold the display when Breeze Kiosk is running in
full screen mode. The right clicks will be ignored but may interrupt the smooth operation of sliding and
selecting images. "Press and hold" right click can be disabled by selecting "Pen and Touch" in the
Windows Control Panel then select the "Press and hold" option and click on the "Settings..." button.
Then uncheck "Enable press and hold for right-clicking":
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4 Preferences

Click on "File->Preferences" or the "Settings" button in the main window to display the preferences
dialog:

Click on the "General" tab to setup the folder to monitor for images and to specify which actions
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(printing, emailing, texting, posting to Twitter) are available to users.

Click on the "Display Settings" tab to specify the size and appearance of the main kiosk display.

Click on the "Slideshow" tab to setup a slideshow to run when the kiosk is not in use.

Click on the "Movies" tab to setup how movie and video files should be handled

Click on the "Caching" tab to adjust the number of images cached in memory. Use a larger cache for
computers with lots of RAM or a smaller cache for computers with limited RAM.

4.1 General Preferences

The "General" preferences tab to allows you setup the folder to monitor for images and to specify
which actions (printing, emailing, Tweeting) are available to users.

The "Folder to monitor for images:" text box specifies where Breeze Kiosk will look for JPEG images to
display. You can either type in a folder name in the text box or click on the "..." button to the right of the
text box to open a folder browser to select the folder.
The folder name can also contain tokens for the date which are replaced with the actual date values
when full screen mode is selected. In the screenshot above the tokens %Y-%m-%D have been used.
%Y will be replaced by the year with century e.g. 2016. %m will be replaced with the two digit month
number e.g. 01 for January. %D will be replaced with the two digit date e.g. 21.
For example: on January 21, 2016 the tokens %Y-%m-%D will be replaced by 2016-01-21.
Please see the section on Tokens for a list of tokens you can use.

Select "Scan subfolders for images" to scan the images folder and all its subfolders.

Select the image types to display using the "Display JPEGs", "Display GIFs" and "Display MP4 and
MOV movies" checkboxes.
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Please note: at least one image type needs to be selected.

The "Stable time (secs):" settings specifies how long a file must remain stable (i.e. size and timestamp
unchanged) before it is displayed. Set this to a low value, e.g. 5 or 10 secs, if Breeze Kiosk is
monitoring images and videos created by another application on the same computer (e.g. a photo
booth). A higher value to allow for possible network delays may be necessary if the images and videos
are being accessed across a network or the folder being monitored is synced via the cloud (e.g.
DropBox or OneDrive).

When the "Startup in full screen mode" option is selected Breeze Kiosk will automatically switch to full
screen mode when it is started.

Images are displayed in alphabetical order unless the "Display newest images first" option is selected
in which case they are displayed in reverse alphabetical order. If the photos are named with sequential
numbering or prefixed with the date and time in YYYYMMDDhhmms format then alphabetical sorting
will be the same as sorting the file chronologically.

Select the "Display new images when they are added" to automatically select and display new images
and videos are added to the folder being monitored.

Select "Sort images by timestamp" to sort the images using their file timestamp. If this option is not
selected the images will be sorted in alphabetical order using their filenames.

Select the "Show mouse cursor" option to display the mouse pointer when in full screen mode. This
makes it possible to control Breeze Kiosk using a mouse if a touchscreen is not available.

Screen Images

The "Folder containing screen images:" text box specifies where Breeze Kiosk will look for screen
images and backgrounds to display. The screen images should be JPEGs which are the same size as
the computer's display resolution e.g. 1366 x 768 pixels. If Breeze Kiosk cannot find a JPEG screen
image for the current action it will supply a default screen instead.

The following screen images can be defined:
background.jpg - the background displayed in the main kiosk view (and thumbnail grid if
grid_background.jpg not defined)
grid_background.jpg - the background displayed in the thumbnail grid 
main_background.jpg - the background displayed when a photo has been selected in the grid view
slideshow_background.jpg - the background displayed when a slideshow is running
print.jpg - the background displayed when the print confirmation screen is displayed
print_payment.jpg - the background displayed when the print confirmation screen is displayed in print
payment mode
print_payment<n>.jpg - the background displayed when the print confirmation screen is displayed in
print payment mode when more than one copy can be selected
printing.jpg - screen displayed when printing the photo
delete.jpg - screen image displayed when deleting a photo
no_images_background.jpg - optional screen image displayed if no images are available
email_photo.jpg - screen displayed when emailing a photo
email_success.jpg - screen displayed after an email has been sent successfully
email_offline.jpg - screen displayed in offline mode after the user has entered their email address
email_error.jpg - screen displayed if there is an error when sending an email
sms.jpg - screen displayed when sending an SMS
sms_success.jpg - screen displayed after an SMS has been sent successfully
sms_offline.jpg - screen displayed in offline mode after the user has entered their cellphone number to
send an SMS
sms_error.jpg - screen displayed if there is an error when sending an SMS
mms.jpg - screen displayed when sending an MMS



Preferences 17

© 2021 Breeze Systems Ltd

mms_success.jpg - screen displayed after an MMS has been sent successfully
mms_as_sms.jpg - screen displayed in if MMS isn't supported and SMS is being used instead
mms_offline.jpg - screen displayed in offline mode after the user has entered their cellphone number
to send an MMS
mms_error.jpg - screen displayed if there is an error when sending an MMS
startup.jpg - screen displayed at startup while Kiosk performs an initial scan of the image folder
twitter_login.jpg - screen displayed when logging in to Twitter
twitter_login_failure.jpg - screen displayed if there is an error logging in to the user's Twitter account
twitter_upload.jpg - screen displayed while the photo is being uploaded to the user's Twitter feed
twitter_success.jpg - screen displayed after a successful post to Twitter
twitter_cancel.jpg - screen displayed if the user cancels a post to Twitter
twitter_error.jpg - screen displayed if there is an error posting the photo to Twitter
twitter_timeout - screen displayed if the user does nothing and the Twitter timeout occurs

Scrollbar and Thumbnail Checkboxes
The appearance of the scrollbar shown in the thumbnail views can be changed using the size and
color settings in Display Settings. A icon, defined by a PNG image, is placed in the scrollbar
background at the top and bottom of the scrollbar. The icon image is named scrollbar-jump-icon.png if
"Jump to top/bottom in scrollbar" is selected in the Display Settings or scrollbar-icon.png if "Jump to
top/bottom in scrollbar" is not selected. The PNG image is resized to fit the width of the scrollbar and is
drawn at the top of the scrollbar. It is then rotated through 180 degrees and is drawn at the bottom of
the scrollbar.
Tip: To define an image for the whole of the scrollbar background make it the same width as the
scrollbar and the same height as the display.

When the clipboard is enabled optional checkboxes can be displayed in the top left corners of
thumbnails. The checkboxes are defined using the following PNG images: thumbnail_checked.png for
thumbnails that have been selected and copied to the clipboard, thumbnail_unchecked.png for
thumbnails that are not in the clipboard and clipboard_close_button.png for images in the clipboard.

You can use the default icons for the srcollbar and thumbnail checkboxes (these can be found in the
installation folder) or you can provide your own by saving them in the "Folder containing screen
images". The icons are defined using PNG images which can have transparent areas by using an
alpha channel.

Layout of the Main Kiosk Screen

The main kiosk screen defaults to a dark blue background with thumbnails displayed on the left with
the main display area showing the currently selected photo with the drawing/signing, print, email,
texting and Twitter icons below it:
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The screen layout and the size and appearance of thumbnails, captions etc. can be adjusting using
the display settings. A JPEG screen image can be used to replace the solid colored background by
placing a JPEG named background.jpg in the screen image folder. PNG icon images can be used for
the print, email, SMS, MMS and Twitter actions. These PNG icons should be named draw-icon.png,
printer-icon.png, email-icon.png, sms-icon.png, mms-icon.png and twitter-icon.png respectively. If no
background screen is defined Breeze Kiosk will look in the installation folder for the default icons. If a
background.jpg screen image is found in the screen images folder Breeze Kiosk will look in the screen
images folder for the icons.

The positions of the touch sensitive areas for the print, email, texting and Twitter icons depend on how
many actions are defined. If one action is defined the touch sensitive area will be centered half way
across the main display area at the bottom of the screen. If two actions are defined the touch sensitive
areas will be centered 1/3 and 2/3 of the width of the main display area at the bottom of the screen. If
three actions are defined the touch sensitive areas will be centered 1/4, 1/2 and 3/4 of the width of the
main display area at the bottom of the screen.

Running a Kiosk without a Touchscreen

Breeze Kiosk is designed to be used with a touchscreen, but it can be operated using a mouse or a
keyboard. To control it using a mouse select the "Show mouse cursor" option in the "General" tab.
Users will then be able click on thumbnails to select an image or click to the left or right of the main
image display to select the previous or next image. They can also click on the icons at the bottom to
select printing, emailing etc. and then click on the touchscreen keyboard keys to enter their email
address or cellphone number.

Breeze Kiosk can also be operated using a keyboard using the key presses below:
cursor left, cursor up, page up, numberpad 4 or numberpad 8: select previous image
cursor right, cursor down, page down, numberpad 2 or numberpad 6: select next image
Home key: select first image
End key: select last image
E: email image
M: send MMS
P: print photo
S: send SMS
T: post image to Twitter
Ctrl+Delete: delete the currently selected image
Esc: exit full screen mode unless it is password protected in which case the password must be entered

Please note: If users are given access to a keyboard you need to prevent them from being breaking
out of full screen kiosk mode by typing Ctrl+Alt+Delete or Alt+Tab. One way to do this is to modify a
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keyboard and physically disable the Alt key. Other options are to run Windows Kiosk utilities which lock
down the computer so that it will only run one program.

Drawing on and Signing Photos

Select "Drawing and signing of photos" to add the option for guests to draw on or sign the photos, add
emojis, frames etc. When the guest taps the drawing/signing icon the drawing and signing screen is
displayed with tools for drawing on the photo, adding emojis or stickers and for choosing different
frames. When the guest saves the changes the edited photo is saved as a new JPEG image with _1
appended to the original image's filename.
Please see Signing or Drawing on Photos for details.

Printing Photos

Select the "Print" checkbox to allow users to print photos. The printer can be setup by selecting
"Printer setup..." from the File menu in the main window.
Click on the "Printer settings..." button to setup the printing options:

The "Minimum time to display printing screen (secs):" setting specifies the minimum time the printing.
jpg screen should be displayed when printing a page. This gives the user feedback that the photos is
being printed.

The "Print screen timeout (secs, 0=disabled):" setting specifies the timeout for displaying the print
screen. This defaults to 30 secs and can be disabled by setting the timeout to 0.

The "Print payment mode" checkbox allows pay per print operation. When this option is selected the
print confirmation screen will display "Print: please make your payment..." when waiting for a payment.
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If the maximum number of copies the user can select is set to more than 1 the normal print screen will
be displayed first allowing users to select the number of copies to print. Then when the user taps the
print icon the payment screen will be displayed.
When the payment screen is displayed the payment can be accepted either by pressing F6 or by
sending a "payment accepted" command to Kiosk. The photos will be printed when the payment is
accepted. 
The payment screen will be cancelled if a "payment cancelled" command is received, the user to taps
the "Cancel" button (in the top or bottom right corners of the screen) or the print timeout to occurs. The
photos will not be printed if the payment screen is cancelled.
The default print payment screens can be changed by creating the following screen images:
print_payment.jpg - print payment screen displayed when the maximum number of copies is set to 1
print.jpg - screen allowing the user to select the number of prints when the maximum number of copies
is set to more than 1
print_payment<n>.jpg - print payment screen displayed when the maximum number of copies is set
more than 1 after the user has selected the number of copies and tapped the print icon in the print
screen. <n> is set to the number of copies the user selected e.g. print_payment1.jpg, print_payment2.
jpg etc.
Please see the section on Payment Options for more information on how to set up a payment system.

When the "Check 'prints' subfolder for printer friendly version of the image, GIF or movie file" is
selected Breeze Kiosk will check the subfolder named prints for a JPEG file of the same name as the
currently selected image when printing. If it can't find a JPEG in the prints subfolder it will also look in
the prints subfolder of the parent folder.
e.g. source image C:\photos\20210721\GIF\203452.GIF
Looks for 203452.JPG in C:\photos\20210721\GIF\prints, if not found it looks in C:\photos\20210721
\prints
If it finds a JPEG image of the same name in the prints subfolder it will print this instead of the selected
image.
This is useful if animated GIFs or movies files are selected because a printable JPEG image can be
provided for printing. Another use is when offering the option to share or print JPEGs from a photo
booth which prints in a format that doesn't look good on screen or in an email (e.g. 6x2 strips). In this
case the JPEG copy of the output from the photo booth can be saved in the prints subfolder and a
screen/sharing friendly version can be created in the main folder using an program such as Breeze
Systems' Hotfolder Prints.

Normally multiple copies are printed as a single document which reduces the time to print when using
a single printer. Select the "Print copies as separate documents" to print each copy as a single
document. This can increase print throughput when using printer pooling with multiple printers.

The "Auto bleed" option automatically extends the the edges of a photo to fill the full area of the
printer's print extent e.g. if a photo is 1800x1600 pixels in size and printer may have a print extent of
1864x1228 pixels when printing 6"x4" @ 300 DPI. When "Auto bleed" is enable the photo is placed in
the center of the print extent and a one pixel wide strip on each edge is extended to fill the print extent.
This will avoid small strips of white appearing on the edges of the print which can occur if the printer
heads aren't perfectly aligned.

Select the "Ask for email address before printing option" to display a touchscreen keyboard asking the
user to enter the email address before printing the photos. If "Require email address before printing" is
selected the user must enter an email address before they can print.
The email address entered by the user will be stored in the email address log file set up in the email
server settings.
The log file contains a line for each email address containing the following comma separated values:
the date in the format YYYYMMDD, the time in the format HHMMSS, the email address, the status
(2=print email address, 1=email success, 0=email failure) and the filename of the image file e.g.
20170114,174842,sales@breezesys.com,2,C:\Users\Chris\Documents\PhotoboothImages\2017-01-14
\prints\170114_174826.jpg

http://breezesys.com/Hotfolder/index.htm
http://breezesys.com/Hotfolder/index.htm
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Select the "Disable printing of GIF images" if Breeze Kiosk is displaying a mixture of JPEG images and
animated GIFs and you don't want people to try to print the animated GIFs. When this option is
enabled the error message will be displayed if the user tries to print an animated GIF unless the
"Check 'prints' subfolder for printer friendly version of the image, GIF or movie file" option is selected
and a JPEG image with the same filename is found in the prints subfolder.

Select the "Disable printing of videos and movies" if Breeze Kiosk is displaying a mixture of JPEG
images and videos and you don't want people to try to print the videos. When this option is enabled the
error message will be displayed if the user tries to print a movie or video unless the "Check 'prints'
subfolder for printer friendly version of the image, GIF or movie file" option is selected and a JPEG
image with the same filename is found in the prints subfolder.

The "Maximum number of copies user can select" option allows you to give users the option to choose
how many copies of the photo to print. If this is set to more than one the print screen will display
touchscreen areas to "Cancel" and "Print" followed by the number of copies currently selected. The
user can increase the number of copies (up to the maximum number allowed) by tapping the screen to
the left of the print copies counter and decrease it by tapping to the right of the counter.

The print limiting settings can be used to limit the number of times each photo is printed. The first
setting, "Maximum number of prints per photo (0=unlimited):", applies to all photos. Set this to the
maximum number of times that each photo can be printed or set it to 0 to disable print limiting. When
the maximum print limit is reached the message in the "Error message to display when limit reached"
text box will be displayed.

A second print limiting option is available which limits prints by matching part of the photo's filename.
One example of this is limiting the number of prints of Instagram photos that can be made for each
Instagram user. If you use our Instagram Hashtag Monitor software to download photos from
Instagram the photos have names like this 145570666745836321_21854356.jpg. The first part of the
filename, 145570666745836321, identifies the photo and the second part, 21854356, identifies the
author of the posting. By setting "Limit number of prints for filenames matching this pattern:" to {field,2,
{filename}} you can limit the number of prints for each Instagram user.
The token {filename} returns the filename of the photo and the token {field,2,{filename}} returns the
second field in the filename i.e. the author id.
Please note: The Instagram Hashtag Monitor comes with Breeze Systems' Hotfolder Prints software
which is a separate purchase.

When printing the photo will be rotated and sized to fill the page.

When the user taps on the print icon a print confirmation screen is displayed. The default screen
shows a print preview on a black background with "Cancel" and "Print" displayed at the bottom of the
screen. The sensitive area for the "Cancel" action is centered 2/5th the way across the screen and the
sensitive area area for the "Print" action is centered 3/5th the way across the screen, If the maximum
number of prints a user is allowed to select is more than 1 the currently selected number of copies will
be displayed 4/5th across the screen with the sensitive area to increase the number of copies to the
left and the decrease to the right.

If the user taps on the "Cancel" area the screen returns to the main kiosk display without printing the
photo. If the user taps on the "Print" area the photo is sent to the printer and the printing screen is
displayed. If the user taps to the left of the print copies counter it will be incremented by 1 (up to the
maximum number of copies allowed). If the user taps to the right of the print copies counter it will be
decremented by 1.
The default printing screen displays the word "Printing..." on a black background. After the print has
been sent to the printer the display returns to the main kiosk display.

JPEG screen images can be used for the print and printing screen by placing the following screen
images in the screen image folder:
print.jpg - the background displayed when the print confirmation screen is displayed

http://www.breezesys.com/Hotfolder/index.htm
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printing.jpg - screen displayed when printing the photo

The touch sensitive area for the "Cancel" action is at the bottom of the screen centered 2/5 of the width
of the screen. The touch sensitive area for the "Print" action is at the bottom of the screen centered 3/5
of the width of the screen.  The touch sensitive areas for increasing or decreasing the number of
copies to print are at the bottom of the screen either side of the point located at 4/5 of the width of the
screen.

Printing Photos Different Printer Settings
Up to three different sets of printer settings can be used to print photos and these can be selected
using the file names of the photos. This allows Breeze Kiosk to print a mixture of different print sizes e.
g. 6x2 strips, 6x4 standard prints or 6x8 large prints based on the filenames of the photos. To set this
up select File->Printer Setup...

The filters can be a simple text prefix (e.g. 6x2 or 6x4) or a regular expression (e.g. 6x2.*DNP). When
printing photos Breeze Kiosk will compare the filename against the filter for printer 2 and will use those
printer settings if the filter matches the filename and the printer is defined. If printer 2 doesn't match it
compares the filename against the filter for printer 3. If this doesn't match it will print using the default
printer settings.
Example: Breeze Kiosk is displaying three different print layouts: traditional 6x2 strips, 6x6 square
prints or 6x8 large prints. The filenames for the photos could be prefixed with 6x2, 6x6 and 6x8
respectively and Breeze Kiosk would be set up so that the default printer prints 6x2 strips, printer 2 is
set up for 6x6 printers has the filter "6x6", printer 3 is set up for 6x8 printers has the filter "6x8".

Select the "Print as double strip" if the photos to be printed are 6x2 strips and the printer is a dyesub
printer than can only print 6x2 strips by printing a 6x4 page and cutting it in half to form two 6x2 strips.
When this option is selected Breeze Kiosk will double the width of the image before sending it to the
printer. It will also divide the number of copies to print by 2 e.g. 1 or 2 copies selected - prints a single
page, 3 or 4 copies selected - prints 2 pages. 

Color Management When Printing
Optional color management can be applied to the photos before printing. To set this up select File-
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>Color Management Settings... and the dialog below will be displayed:

Enable color management using the "Enable color management when printing" checkbox. Then enter
the color space used for the photos (this is normally sRGB) and the color profile for your printer.

Emailing Photos

Select the "Email" checkbox to allow users to email photos and then press the "Email settings..."
button to edit the settings:

The "Subject:" text box defines the text in the subject line of the email.

The body text of the message can be specified in plain text or in HTML format to provide more control
over its appearance. When using the HTML format the token {image} represents the URL of the photo
to be emailed and can be used with HTML <img> tag e.g. <img src="{image}">.
The simplest way to create a complex HTML format message is to use an HTML editor or to compose
a suitable email in an email program and then copy the HTML into the "Message (HTML format)" field
and replace the image URL with {image}.
Please note: It isn't possible to embed an attached movie or video file into an HTML formatted email
message. When sending a movie or video the file will appear as an attachment to the email. 

Tokens for the date and time can be included in the email subject and message text fields and will be
replaced with the date or time the photos were taken when they are uploaded e.g.
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%L will be replaced with the long date representation for your computer's locale e.g. Wednesday,
January 08, 2014
%l will be replaced with the long date and time representation for your computer's locale e.g.
Wednesday, January 08, 2014 20:23:56
Please see the tokens section for a list of available tokens.

Select the "Attach image to email" option to send the image with the email as an attachment (this is the
default option). If this option is disabled the image won't be attached to the email and you need to
provide a link to a website where users can view their photos. For example you might use an FTP
client to automatically upload the photos to your website and then provide a link to the photo in the
email by replacing the line:
<p><img src="{image}"></p>
with something like this:
<p><img src="http://mywebsite.com/photos/{fullFilename}"></p>

You can crop, resize and rotate the photo before it is emailed to the user.
To crop the image first check the "Crop image:" checkbox and then specify the left offset and top offset
in pixels for the top left corner of the cropped image. Then specify the width and height of the image in
pixels. For example if the photos are from a photobooth which is setup to print a double strip of 4
images on 6"x4" paper you may wish to crop the image so that only a single strip is emailed to the
user. If the printer is set to a resolution of 300 dpi the image will be 1200 pixels wide (4" x 300 dpi) by
1800 pixles high (6" x 300 DPI) and so to crop it into a single strip you need to set left=0, top=0,
width=600 and height=1800.
You can also specify a maximum size for the image being uploaded using the "Max width (pixels):" and
"Max height (pixels):" settings. The JPEG copy of the printed output will be resized so that it is no
bigger than these settings before it is emailed. Keeping these values relatively small, e.g. 500 x 500
pixels, will reduce the time it takes to send the email.
If required, the photo can be rotated using the "Image rotation:" dropdown list.
Please note that the image is cropped first, then resized and finally rotated before being emailed to the
user.

By default the screens displayed when emailing the photo will have a simple status message shown on
a black background. This can be overridden by placing the following JPEG screen images in the
screen images folder:
email_photo.jpg - screen displayed when emailing a photo (email_offline.jpg is displayed if the offline
mode is selected)
email_success.jpg - screen displayed after an email has been sent successfully
email_error.jpg - screen displayed if there is an error when sending an email
email_offline.jpg - screen displayed when using offline mode and saving the email for sending later

When the user taps the email icon in the main kiosk display a touchscreen keyboard will displayed to
allow the user to enter their email address. Please see the touchscreen keyboard section for
information on how to customize its layout and appearance. The touchscreen keyboard layout can be
tested by clicking on the "Test keyboard..." button.

Sending an SMS

SMS messages are short text messages of up to 160 characters sent to a cellphone. Breeze Kiosk
can be used to send an email to an email to SMS forwarding service which sends the SMS message
to the user's cellphone. An SMS message is text only and does not include the actual photo. The text
can be a URL to where the image is stored on a web server and on most cellphones the user can tap
on the link and open a web browser to view the web page.
Please note:
1) email to SMS services are usually subscription based not free
2) You can also use the "Sending an MMS" option to send SMS messages using Twilio.com

Select the "SMS" checkbox to allow users to send an SMS message to their cellphone and then press
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the "SMS settings..." button to edit the settings:

The settings will depend on the email to SMS service you are using. The settings above are suitable
for the UK based "text local" service (http://www.textlocal.com). For this service the email address is
the cellphone number followed by @txtlocal.co.uk. The token {number} is replaced by the cellphone
number entered by the user and so the email address is set to {number}@txtlocal.co.uk.
The subject line is used to pass additional information to the service such as your password.
The message text contains the message text that is sent in the SMS message and should be no more
than 160 characters in length. The example above sends an SMS containing the URL to access an
Instagram post on the WEBSTA Instagram Web Viewer website (websta.me). This assumes that the
photo has been downloaded using Breeze Systems' Instagram Hashtag Monitor and has a filename
containing the post id followed by the user id e.g. 145570666745836321_21854356.jpg. The token
{field,1,{filename}} extracts the first field from the filename e.g. 145570666745836321

This is an alternative URL for viewing the Instagram post:
http://iconosquare.com/viewer.php#/detail/{field,1,{filename}}

Here are some other URLs that could be used to view Instagram posts made by the same author:
https://instagram.com/{field,2,{filename}}
http://websta.me/n/{field,2,{filename}}
http://extragr.am/{field,2,{filename}}
http://iconosquare.com/viewer.php#/user/{field,2,{filename}}

If you are using Breeze Kiosk to view photos from a photo booth and have a website for viewing the
photos online you could text a URL like this:
http://www.yoursite.com/display.php?id={filename}
For this to work you need to use additional software to upload the photos to your website either during
or after the event e.g. an FTP client that can automatically sync files stored locally with your website.
You also need to have suitable scripts to view the photo on your website.

Tokens for the date and time can be also included in the email subject and message text fields and will
be replaced with the date or time the photos were taken when they are uploaded e.g.
{number} will be replaced with the cellphone number entered by the user
%L will be replaced with the long date representation for your computer's locale e.g. Wednesday,
January 08, 2014
%l will be replaced with the long date and time representation for your computer's locale e.g.
Wednesday, January 08, 2014 20:23:56
Please see the tokens section for a list of available tokens.

By default the screens displayed when sending an SMS will have a simple status message shown on a
black background. This can be overridden by placing the following JPEG screen images in the screen
images folder:sms_photo.jpg - screen displayed when emailing the SMS message (sms_offline.jpg is
displayed if the offline mode is selected)
sms_success.jpg - screen displayed after an email has been sent successfully

http://www.textlocal.com


 26

© 2021 Breeze Systems Ltd

sms_error.jpg - screen displayed if there is an error when sending an email
sms_offline.jpg - screen displayed when using offline mode and saving the email for sending later

When the user taps the SMS icon in the main kiosk display a touchscreen keyboard will displayed to
allow the user to enter their cellphone number. Please see the touchscreen keyboard section for
information on how to customize its layout and appearance. The touchscreen keyboard layout can be
tested by clicking on the "Test keyboard..." button.

Email Server Settings

The email server settings also need to be setup so that the program can email the photos or send
SMS messages via email. The "Email Server Settings" dialog can be opened by selecting "Email
Server Settings..." from the File menu or by clicking on the "Email server settings..." button in the
"Output Settings" dialog. The "Email Server Settings" dialog shown below will be displayed:

To send an email you need to specify the host name and port number of your email server. Most email
servers also require a username and a password to prevent unauthorized users from sending spam
emails. For additional security select the "Use SSL for secure email" option to send the email using
SSL. The port number should normally be set to 587 when using SSL secure email or 25 otherwise
(please check the port numbers used by your ISP). Google's free GMail service is a convenient way to
send emails and can be set up using the settings shown above and replacing yourname@gmail.com
with your GMail email address and entering your password. Set the "Email addr:" to the sender's email
address. Most ISPs require the sender's email address to the be the same as that of the email account
specified by the username and password.

Using GMail to send emails
In spring 2020 Google withdrew support for standard SMTP emails and replaced it with a more secure
service linked to your Google account. Breeze Kiosk v2.0 has received app approval from Google
which allows it to send emails using this new secure method. To use GMail to send emails you need to
authorize it with your Google account. To do this first set the "Host" to GMail and then click on the
"GMail authenticate..." button. This will open a web browser window guiding you through the
acceptance process. If the PC has already been authenticated pressing the "GMail authenticate..."
button will refresh the GMail access token and display its status.
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If you decide to stop allowing Breeze Kiosk to send emails using GMail you can revoke its access by
logging in to your Google account and going to the Security settings and "Third-party apps with
account access". You should see an entry for Breeze Booth which you can click on to review its
access. If you decide to remove access this will prevent all copies of Breeze Kiosk from sending
emails using GMail and you will need to re-authenticate them if you to use GMail on them
again.Breeze Kiosk only has permission to send emails on your behalf using GMail. It is not able to
read, modify or delete your emails and does not have access to any other Google services you may
use.

Switching to a different GMail account: The GMail email account used to send the emails can be
changed by signing into the Google account settings for the current account using a web browser and
removing access for Breeze Booth in the security settings. Then re-authenticate in Breeze Kiosk and
select the new account.

Please note: Google limit the number of emails that can be sent from a GMail account to 500 emails in
a 24 hour period which may not be enough if you are running several photo booths. If this is a problem
please consider using a dedicated email service such as sendgrid.com.

The settings can be verified by sending a test email by entering the destination email address and then
clicking on the "Send test email to:" button. The email status and any error messages will be displayed
in the status area at the bottom of the dialog.

Select the "Log email addresses to file:" checkbox to log the email addresses to a CSV file. Then
either type in the filename of the log file in the editbox or click on the "..." to open a file browser. The
log file contains a line for each email containing the following comma separated values: the date in the
format YYYYMMDD, the time in the format HHMMSS, the email address, the status (2=print email
address, 1=email success, 0=email failure) and the filename of the image file e.g.
2017011,174842,test@gmail.com,1,C:\Users\Chris\Documents\PhotoboothImages\2017-01-14
\prints\170114_174826.jpg
2017011,174842,SMS:0123456,1,C:\Users\Chris\Documents\PhotoboothImages\2017-01-14
\prints\170114_174826.jpg
Click here for information on sending the messages after the event.

Select "Save XML copy of email" to save an XML copy of the email including the message text,
subject, email address and user inputs. The XML file is saved in the same folder as the photos being
emailed and is given a filename prefix of email_YYYMMDD_hhmmss_. Click on the "Attachment
settings..." button to display the "XML Email Attachment Settings" dialog to specify how email
attachments are saved in the XML copy of the email when sending MP4 videos:

Select the types of attachments to be included when emailing MP4 videos. The options are: "MP4 only"
which attaches the MP4 file to the email, "JPEG preview only" which extracts a preview image from the
MP4 movie and attaches it to the email, "MP4 and JPEG preview" which attaches both the MP4 file
and the JPEG preview to the email. Use the "Max size of MP4 preview (pixels)" settings to specify the
maximum width and height of the JPEG preview extracted from the MP4 file.

The XML copies of the emails can be processed automatically using Breeze Hub. This allows emails
to be sent in the background so that users don't have to wait before taking the next set of photos in the
photo booth. This method also allows for more sophisticated emails to be sent e.g. sending a JPEG
preview of a movie with the movie attached to the email or sending a slideshow GIF together with
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copies of the individual photos.
Attachments for JPEG images (including preview created from MP4 videos) and GIF images can be
embedded in HTML emails using the {image} token followed by the attachment number e.g. {image} or
{image1} for the first attachment, {image2} for the second attachment e.g.
<p>Attachment 1: <img src="{image1}"></p>
<p>Attachment 2: <img src="{image2}"></p>
If there is no corresponding {image} token for the attachment in the HTML email text or if the
attachment is a MP4 movie file it will be attached to the email and won't be embedded in the email text.

Please note that the "Save XML copy of email" option is experimental and the details may change in a
future release.

Sending an MMS (or SMS)

MMS messages can be sent in the US and Canada using a web-based service called Twilio (www.
twilio.com). In other countries the message can be sent as an SMS message with a link to the photo.
Most cellphones should recognize the link as a link to a web server and open a web browser on the
user's cellphone to view the photo. Please note that the image link in an SMS will only be valid for 7
days.

To use this service you need an account with Twilio and enter you Twilio account details in the MMS
setting dialog. Twilio charge for each MMS or SMS message sent using their service. Please see their
website for pricing information.
The maximum image or video file size that can be sent is 2 MB, but Twilio may resize the image file to
conform to the cellphone service provider's size requirements.

Enter your Twilio message phone number, AccountSID and AuthToken in the "MMS Settings" dialog.
You can find your Twilio message phone number, AccountSID and AuthToken by logging into your
Twilio account.

Set the country prefix to your country prefix e.g. +1 for the US and Canada, +44 for the UK, +49 for
Germany etc. When users enter their cellphone numbers they can either enter the number with their
country prefix e.g. +1234567890 or without it e.g. 23456789 and the country prefix will be added
automatically before sending the text.

http://www.twilio.com)
http://www.twilio.com)
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Select the message type from the "Message type:" dropdown list. The available options are:
1. MMS - send the message as an MMS with the image attached to the message. Currently Twilio only

supports MMS messaging in the US and Canada. If this option is used in a country which doesn't
support MMS messaging through Twilio the message will be sent as an SMS + image. 

2. SMS - send the message as an SMS. You will need to include a link to a website in the message
text so that the user can view their photos e.g. http://mywebsite.com/photos/{fullFilename}

3. SMS + image - send the message as an SMS with a link to the photo. The photo will only be
available for viewing for 7 days. Use the {url} token to include the URL to the image in the text
message. If the {url} token is not included in the message the URL will be appended to the end of
the message.

Photos sent using the "MMS" and "SMS + image" options must be no more than 1MB in size after
resizing and cropping. An error message will be displayed if the 1MB file size limited is exceeded.
Twilio may resize the photo to conform with the cellphone service operator's MMS size limits.
Photos sent using the "SMS + image" and "MMS" options will be hosted on the Breeze Systems'
website for 7 days.

You can specify a maximum message length to ensure the 160 character SMS message length is not
exceeded. In some countries SMS messages of more than 160 characters may be sent as multiple
SMS messages and will cost more. In other countries the SMS message will be truncated to 160
characters.

You can crop, resize and rotate the JPEG photos, but not animated GIFs, before they are sent to the
user. 
To crop the image first check the "Crop image:" checkbox and then specify the left offset and top offset
in pixels for the top left corner of the cropped image. Then specify the width and height of the image in
pixels. For example if the photos are from a photobooth which is setup to print a double strip of 4
images on 6"x4" paper you may wish to crop the image so that only a single strip is emailed to the
user. If the printer is set to a resolution of 300 dpi the image will be 1200 pixels wide (4" x 300 dpi) by
1800 pixels high (6" x 300 DPI) and so to crop it into a single strip you need to set left=0, top=0,
width=600 and height=1800.
You can also specify a maximum size for the image being uploaded using the "Max width (pixels):" and
"Max height (pixels):" settings. The JPEG copy of the printed output will be resized so that it is no
bigger than these settings before it is emailed. Keeping these values relatively small, e.g. 500 x 500
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pixels, will reduce the time it takes to send the email.
If required, the photo can be rotated using the "Image rotation:" dropdown list.
Please note that the image is cropped first, then resized and finally rotated before being sent to the
user.

You can specify a timeout for uploading the photo and a upload progress message that is displayed
during the upload. The default file upload message is "Uploading: {percentage}%". During the upload
the {percentage} token will be replaced with the upload progress expressed as a percentage. Leave
the "Progress message" blank to disable upload progress messages.

By default the screens displayed when sending an MMS or SMS will have a simple status message
shown on a black background. This can be overridden by placing the following JPEG screen images in
the screen images folder:
mms.jpg - screen displayed when sending an MMS
mms_success.jpg - screen displayed after an MMS has been sent successfully
mms_as_sms.jpg - screen displayed in if MMS isn't supported and SMS is being used instead
mms_error.jpg - screen displayed if there is an error when sending an MMS

Select the "Log uploads to file:" checkbox to log the cellphone numbers to a CSV file. Then either type
in the filename of the log file in the editbox or click on the "..." to open a file browser. The log file
contains a line for each message containing the following comma separated values: the date in the
format YYYYMMDD, the time in the format HHMMSS, the cellphone number prefixed by MMS:, the
status (1=success, 0=failure) and the filename of the image file e.g.
2015011,174842,MMS:0123456,1,C:\Users\Chris\Documents\PhotoboothImages\2015-01-14
\prints\150114_174826.jpg
Click here for information on sending the messages after the event.

Select "Save XML copy of text" to save an XML copy of the text including the message text, phone
number and user inputs. The XML file is saved in the same folder as the photos being emailed and is
given a filename prefix of text_YYYMMDD_hhmmss_. Please note that this option is experimental and
the details may change in a future release.

When the user taps the MMS icon in the main kiosk display a touchscreen keyboard will displayed to
allow the user to enter their cellphone number. Please see the touchscreen keyboard section for
information on how to customize its layout and appearance. The touchscreen keyboard layout can be
tested by clicking on the "Test keyboard..." button.

Posting Photos and Videos to the User's Twitter Feed

Users can post photos, animated GIFs and videos to their Twitter feed directly from Breeze Kiosk if it
has an internet connection. Select the "Twitter" checkbox to allow users to upload photos to Twitter
and then press the "Twitter settings..." button to display the "Twitter Settings" dialog:
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Enter the Twitter message in the comment field. Twitter allows tweets of up to 140 characters but
around 20 characters are used up by posting a photo and so the maximum message length is about
120 characters.
Tokens for the date and time can be included in comment and will be replaced with the date or time
the photos were taken when they are uploaded e.g.
%L will be replaced with the long date representation for your computer's locale e.g. Thursday,
January 08, 2015
%l will be replaced with the long date and time representation for your computer's locale e.g.
Thursday, January 08, 2015 20:23:56
Please see the tokens section for a list of available tokens.

You can crop, resize and rotate photos (but not animated GIfs or videos) before uploading it to Twitter.
To crop the image first check the "Crop image:" checkbox and then specify the left offset and top offset
in pixels for the top left corner of the cropped image. Then specify the width and height of the image in
pixels. For example if the photos are from a photobooth which is setup to print a double strip of 4
images on 6"x4" paper you may wish to crop the image uploaded to Twitter so that only a single strip is
sent. If the printer is set to a resolution of 300 dpi the image will be 1200 pixels wide (4" x 300 dpi) by
1800 pixels high (6" x 300 DPI) and so to crop it into a single strip you need to set left=0, top=0,
width=600 and height=1800.
You can also specify a maximum size for the image being uploaded using the "Max width (pixels):" and
"Max height (pixels):" settings. The JPEG copy of the printed output will be resized so that it is no
bigger than these settings before it is uploaded to Twitter. Keeping these values relatively small, e.g.
500 x 500 pixels, will reduce the time it takes to upload the file.
If required, the photo can be rotated using the "Image rotation:" dropdown list.
Please note that the image is cropped first, then resized and finally rotated before being uploaded to
Twitter.

By default the screens displayed when logging in to Twitter and uploading the photo will have a simple
status message shown on a black background. This can be overridden by placing the following JPEG
screen images in the screen images folder:
twitter_login.jpg - screen displayed when logging in to Twitter
twitter_login_failure.jpg - screen displayed if there is an error logging in to the user's Twitter account
twitter_upload.jpg - screen displayed while the photo is being uploaded to the user's Twitter feed
twitter_success.jpg - screen displayed after a successful post to Twitter
twitter_cancel.jpg - screen displayed if the user cancels a post to Twitter
twitter_error.jpg - screen displayed if there is an error posting the photo to Twitter
twitter_timeout - screen displayed if the user does nothing and the Twitter timeout occurs

The "Upload timeout" setting specifies the timeout when uploading photos or videos to Twitter. It may
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be necessary to increase this setting if the internet connection is slow.
You can specify a upload progress message that is displayed during the upload. The default file upload
message is "Uploading: {percentage}%". During the upload the {percentage} token will be replaced
with the upload progress expressed as a percentage. Leave the "Upload progress message" blank to
disable upload progress messages.

Select the "Log uploads to file:" checkbox to log the details to a CSV file. Then either type in the
filename of the log file in the editbox or click on the "..." to open a file browser. The log file contains a
line for each message containing the following comma separated values: the date in the format
YYYYMMDD, the time in the format HHMMSS, the user's Twitter login name prefixed by
TWITTER_USERNAME:, the status (1=success, 0=failure) and the filename of the image file e.g.
2015011,174842,TWITTER_USERNAME:user@somesite.com,1,C:
\Users\Chris\Documents\PhotoboothImages\2015-01-14\prints\150114_174826.jpg
IMPORTANT: The user's Twitter password is NOT recorded

When the user taps the Twitter icon in the main kiosk display a touchscreen keyboard will displayed to
allow the user to enter their Twitter username and password. Please see the touchscreen keyboard
section for information on how to customize its layout and appearance. The touchscreen keyboard
layout can be tested by clicking on the "Test keyboard..." button.

Sending Emails and MMS/SMS Messages after the Event

If no internet connection is available at an event you can save users' email addresses (and cellphone
numbers for MMS/SMS messages)  and send the messages later when an internet connection is
available.
To log email addresses for sending later you need to select the "Offline mode" option in the email
server settings dialog and select the "Log email addresses to file" option - this will save the user's
email address together with the filename of their photos.
To log cellphone numbers for sending MMS or SMS messages later you need to select the "Offline
mode" option in the MMS settings dialog and select the "Log uploads to file" option - this will save the
user's cellphone number together with the filename of their photos.
Please note: You can use the same log file for both email addresses and cellphone numbers.

The messages can be sent when an internet connection is available by selecting "Send emails and
MMS/SMS messages..." from the "File" menu in the main window. When you select this you will be
asked the log file to read (this defaults to the email log file specified in the "Email Server Settings").
The "Unsent Emails and MMS/SMS Messages" dialog will be displayed listing the date/time, email
address or cellphone number and photo filename for unsent emails found in the log file. Select the
messages you wish to send and then press the "Send" button to send them.
Please note: There is no offline option for Twitter uploads because users need to enter both their
username and password to allow uploading to their Twitter account and no system should ever keep a
record of users' passwords.

4.2 Display Settings

The display settings allow you to adjust the appearance of the main kiosk display:
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Use the "Layout:" dropdown list to choose one of the following display layouts:
1. No thumbnails - only displays a large copy of the currently selected photo or video with icons

displayed below
2. Thumbnails and photo - similar the the "No thumbnails" option but with the addition of thumbnails

displayed vertically down the left hand side
3. Thumbnail grid - displays a grid of thumbnails. When a thumbnail is selected a screen showing a

large copy of the photo or video with icons displayed below and a "Close" cross in the top right
hand corner. The screen will be displayed until the users closes it or the "Full screen timeout"
occurs

4. Privacy mode - users must enter a code (e.g. the image filename) to view and share their photo.
When the correct code has been entered only the matching photo or video will be displayed. 

When the layout is set to "Thumbnails and photo" you can enable a clipboard to allow multiple images
to be selected and shared. Click on the "Multiple selections..." button to enable the clipboard and
configure its settings.
Please see Clipboard and Selecting Multiple Images for more details.

The default layout, "Thumbnails and photos", for the main kiosk is shown below:
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Select the "Thumbnails and photo" layout option to display thumbnails down the left side of the screen.
The with and height of the thumbnails can be specified using the "Thumbnail size (pixels):" setting.

The "Thumbnail size (pixels):" settings specify the width and height of the area used to display each
thumbnail. The "Thumbnail spacing (pixels):" setting specifies the spacing between thumbnails. The
"Crop thumbnails" option can be used to crop a thumbnail image before it is displayed. This is useful if
the thumbnail represents a double strip of three or four photos and you only want to display it as a
single strip.

The thumbnail highlight color setting specifies the color of the outline drawn around the currently
selected thumbnail. Click on the "..." button to the right of the color display to select a different color.
The thumbnails can be cropped before they are displayed by checking the "Crop thumbnails"
checkbox and specifying the area to be cropped. This can be useful if Breeze Kiosk is being used to
display images that have been formatted by Hotfolder Prints after downloading them from Instagram
using Hotfolder Prints' Hashtag Monitor so that the thumbnail only shows the photo part of the
download.

Select the "Thumbnail caption" checkbox to display a caption under each thumbnail. The caption text
can use tokens such as {filename} for the photo's filename and %H:%M:%S for the time.
The font type and size of the thumbnail caption displayed below each thumbnail can be edited by
clicking on the "..." button to the right of the "Caption font:" display. Click on the "..." button to the right
of the caption color display to specify the color used for the thumbnail caption.

The "Scrollbar width (pixels):" setting specifies the width of the scrollbar used for scrolling the
thumbnail display. You can also specify the colors of the scrollbar slider and background area. The
appearance of the scrollbar can also be customized by placing PNG images in the screen images
folder (see general greferences for details).

By default the main area background is dark blue. A different background color can be specified using
the "Window background color" setting. A JPEG image can also be used for the window background
by placing a suitable JPEG image named background.jpg in the screen images folder. Please see the 
general preferences section for more information.

The "Icon area height (pixels):" setting specifies the height of the icon area at the bottom of the main
display area. Please make sure this is large enough to display the print, email and Twitter icons. If it is
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too small the photo displayed in the upper part of the main display area may obscure the icons.

Select "Jump to top/bottom in scrollbar" to enable the ability to jump to the first image by tapping the
top of the scrollbar or to jump to the last image by tapping the bottom of the scrollbar. When this option
is selected the scrollbar-jump-icon.png image will shown at the top and bottom of the scrollbar: When
this option is not selected the scrollbar-icon.png image is displayed at the top and bottom of the
scrollbar. Please see screen images for details.

Select the "Double click in bottom right corner to exit full screen mode" checkbox if you want to be able
to exit full screen mode using the touchscreen. If this option is not selected the only way to exit full
screen mode is to hit the escape key on the keyboard. If the "Require password" checkbox is selected
the touchscreen keyboard will be displayed after double clicking on the bottom right corner and the
software will only exit fullscreen mode if the correct password is entered.
Select the "Double click top right corner to delete" if you want to be able to delete unwanted or
inappropriate images. This option will be protected using the same password as the exit full screen
mode option if "Require password" is selected. After entering the password, if required, a delete
confirmation screen will be displayed. If you choose to delete the photo or video it will be moved to a
subfolder named "DELETED" and removed from the display. The default delete confirmation screen
can be replaced using a screen image named delete.jpg.

By default the full area of each photo is displayed in the thumbnails and in the main display area. The
photos can be cropped before they are displayed by checking the "Crop displayed image" or "Crop
thumbnails" checkboxes and specifying the area to be cropped. This can be useful if Breeze Kiosk is
being used to display images from a photo booth set up for double strip of 4 printing and you only want
to display one strip of the photos in Breeze Kiosk.

The "Max image size (0=auto):" settings specify the maximum display size of images and videos e.g. if
an image is 400x600 pixels in size and the max image size height is set to 300 the image be resized to
200x300 and centered in the main display area. Set this to zero to let Breeze Kiosk size the photos
automatically to fit the display area. The "Max percentage scaling" option specifies the maximum
amount of scaling that will be applied when resizing a photo or video to fit the display area. Normally
this will be set to 100 but it can be used to enlarge videos or animated GIFs which would otherwise
appear very small on a high resolution display. Setting the max scaling too high (e.g. 400) may result in
the photos or videos appearing pixellated.

The "Screen timeout (secs):" setting specifies the timeout for hiding the image screen and returning to
the touchscreen keyboard ready for a new code to be entered.

Select the "Display QR code" checkbox to display a QR code in the bottom right hand corner of the
screen. Enter the next to be encoded in the QR code in the text field to the right of the checkbox. The
text can include tokens to display dynamically generated QR codes.  This could be used to link to a
microsite by using the {filename} token to include the currently displayed image's filename in the URL
e.g.
https://mysite.com/MyEvent/{filename}
or
https://mysite.com/viewer.php?id={filename}

Thumbnail grid layout:
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4.3 Clipboard and Selecting Multiple Images

The clipboard allows users to select one or more images and to share them in a single email. The
clipboard option is only available when the layout is set to "Thumbnails and photo" in the "Display
Settings".
Images can be added to or removed from the clipboard by doubling tapping on a thumbnail or the main
image or the contents of the clipboard. An optional checkbox can be displayed in the top right hand
corner of images and tapping on this checkbox will add or remove the image from the clipboard.

To enable the clipboard go to the "Display Settings" tap, set the layout to "Thumbnails and photo" and
then click on the "Multiple selections..." button:

Select "Enable multiple selections and clipboard" to enable the clipboard.

Select "Hide clipboard when empty" to hide the clipboard display when there are no images held in the
clipboard.

Select "Show checkboxes on thumbnails" to display a checkbox in the top right hand corner of
thumbnails. The checkbox provides a visual indication as to whether the image is held in the clipboard.
Tap the checkbox to add the thumbnail to the clipboard or to remove if from the clipboard. Images can
also be added or removed by double tapping them.
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Select "Tap bottom or right of clipboard" to add a clear button to the right of the clipboard for horizontal
layouts or below the clipboard for vertical layouts. When this option is selected users can tap on the
clear button to empty the clipboard.

The "Maximum number of items in clipboard" setting specifies how many items can be placed in the
clipboard. The default setting is 4.

The clipboard can be automatically cleared if the user doesn't tap the screen by setting the "Timeout in
secs" to 1 or more seconds. If this setting is set to 0 the timeout will be disabled.
The clipboard is automatically cleared after emailing a set of photos.

The remaining settings control how the clipboard is displayed. The clipboard is displayed as an overlay
in the main image area. The main image will appear behind the clipboard if it fills the main image
display area and when the user swipes left or right to select the next or previous image. The maximum
size of the main image can be specified in the "Display Settings". By default the main image is resized
to fit the main image display area but a maximum size can be set to allow more space for the clipboard
display.

The "Thumbnail spacing (pixels)" specifies the space between each thumbnail displayed in the
clipboard and the "Thumbnail size (pixels)" settings specify the width and height of each thumbnail.

The background color setting specifies the background color for the clipboard. The "Background
opacity (0 to 255)" setting specifies the opacity of the clipboard background in the range 0 (fully
transparent) to 255 (fully opaque). Values between 0 and 255 will give a semi transparent background
which allows the main image to be seen behind the clipboard.

The "Outline color" and "Outline width" settings specify the color and width of the outline drawn around
the clipboard.

Use the "Clipboard placement:" dropdown list to specify where the clipboard is displayed in the main
image area. The right and left settings will display a vertical clipboard to the right or left of the main
image area like the one below:

The top and bottom settings will display a horizontal clipboard to the top or bottom of the main image
display area.

The appearance of the clipboard and the thumbnail checkboxes can also be customized by placing
PNG images in the screen images folder (see General Preferences). 
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4.4 Privacy Mode

Privacy mode provides a way to only allow user to view and share their own photos. To use the kiosk
the user must enter a code (e.g. the filename) using the touchscreen keyboard. If the correct code is
entered the image or video is displayed full screen with icons for printing or sharing displayed below.
The kiosk will automatically return to the touchscreen keyboard after a preset timeout or if the user
touches the "close" icon in the top right corner of the display.

To select privacy mode set the layout dropdown list in the display settings to "Privacy mode" and then
click on the "Privacy mode settings..." button to adjust the settings:

Set the "Code matching string:" to how the code entered by the user must match the filename of the
image to be displayed. Set this to {filename} to require the user to enter the full filename (without file
extension) to view an image e.g. to display the JPEG photo IMG_0001.JPG the user would need to
enter IMG_0001. By default the code entered by the user is not case sensitive (e.g. IMG_0001 or
img_0001 would match IMG_0001.JPG). Check the "Case sensitive code matching" checkbox if the
code entered by the user must match the case of the filename.

The error message displayed to the user when they enter an invalid code can be specified using the
"Error message displayed when matching image not found" setting.

To exit privacy mode when the kiosk is running either enter the exit password (if defined in the display
settings) or press Esc.

When using Breeze Kiosk with photo booth software from Breeze Systems the {uid} token can be used
in the photo booth software to generate a unique, hard to guess code for each photo. To use this first
select File->Preferences in the photo booth software and set the filename prefix to {uid} and then
number of digits to 0. e.g. the Preferences dialog in DSLR Remote Pro. would look something like this:
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Then in the photo booth software's print layout add a caption containing something like "Access code:
{uid}":

 Finally, in the photo booth software's "Output Settings" dialog set the filename for the JPEG copy of
the printed output to {uid} e.g.
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The photo booth software will generate a unique 8 character code (e.g. PHU69450) for each set of
photos and display it on the print and use it for the filename of the JPEG copy of the printed output.
This can be matched by setting the "Code matching string" in Breeze Kiosk to {filename}. Additional
information to help identify photos, such as the date and time, can be added to the JPEG filenames by
setting the "Filename for JPEG copy of output" to something like this: {uid}_%d_%t. If this is used the
"Code matching string" in Breeze Kiosk can be set to {left,8,{filename}} so that it only needs to match
the first 8 characters of the filename. 

4.5 Slideshow Settings

An optional slideshow can be displayed when Breeze Kiosk has been inactive for a preset time. The
slideshow preference settings are shown below:
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Check the "Display slideshow when idle" checkbox to enable a slideshow when Breeze Kiosk has been
inactive for a preset time. The "Inactivity timeout (secs):" setting specifies how long Breeze Kiosk
should be idle before the slideshow is displayed. The slideshow will run until the user taps the screen
to return to the main kiosk display.

Select the required slideshow transition from the "Slideshow transition" dropdown list. The following
slideshow transitions are available:
Slide right to left - the screen is filled with the current image and when the next image is displayed the
new image slides in from the right and the current image slides off to the left
Dissolve - the screen is filled with the current image and when the next image is displayed the current
image dissolves into the next image
Fade - the screen is filled with the current image and when the next image is displayed the current
image fades away to the background and then the new image fades in
Next image - the normal full screen kiosk display with thumbnail and main display areas remains on
the screen and the slideshow works by scrolling through the images

The "Interval (secs):" setting specifies how long each photo should be displayed before displaying the
next photo in the slideshow.

By default the slideshow background is dark blue. A JPEG image can also be used for the window
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background by placing a JPEG image named slideshow_background.jpg in the screen images folder.
Please see the general preferences section for more information.

By default the photos are resized to fit the screen. The photo size can be modified using the X offset, Y
offset, width and height settings to allow space for a message display or logo.
The "X offset:" setting specifies where the photo should be displayed left to right, measured in pixels
from the left edge of the screen. Set this to -1 to automatically center the photo horizontally on the
screen.
The "Y offset:" setting specifies where the photo should be displayed up and down, measured in pixels
from the top edge of the screen. Set this to -1 to automatically center the photo vertically on the
screen.
The "Max width:" setting specifies the maximum width in pixels of the photo. If this is set to 0 the photo
will be resized to fit the screen. If it is set to a negative value the photo will be resized to the screen
width less that value e.g. set this to -100 to resize the photo to 100 pixels less than the screen width.
The "Max height:" setting specifies the maximum height in pixels of the photo. If this is set to 0 the
photo will be resized to fit the screen. If it is set to a negative value the photo will be resized to the
screen height less that value e.g. set this to -100 to resize the photo to 100 pixels less than the screen
height.
Using negative values for the maximum width or height settings makes it possible to reserve an area
of the screen to display a caption or logo using a slideshow_background.jpg image.

The slideshow images can be cropped before they are displayed by checking the "Crop slideshow
image" checkbox and specifying the area to be cropped. This can be useful if Breeze Kiosk is being
used to display images that have been formatted by Hotfolder Prints after downloading them from
Instagram using Hotfolder Prints' Hashtag Monitor so that the slideshow only shows the photo part of
the download.

Option adverts or title screens can be show during the slideshow by selecting "Display titles or adverts
during slideshow" checkbox. Then select the folder containing the title or advert images and the
number number of slideshow images to display between title/advert images. For best results the title/
advert images should be the same size in pixels as the display. The images can be JPEGs, animated
GIFs or movie files.
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4.6 Movie and Video Settings

Use the "Automatically start movie playback option" to automatically start playing when they are
displayed in the main display area. If this option is not selected the first frame of the movie will be
displayed. The user can tap  the display to start or pause playback.

When the "Play movie in a continuous loop" option is selected the movie will automatically restart from
the beginning when it reaches the end.

The display "Play" icon on movie thumbnails option specifies whether the play icon (a semi-opaque
triangle with a circle around it) is displayed on thumbnails to indicate that they are movie files. 

The display "Play" icon on movies when paused option specifies whether the play icon (a semi-opaque
triangle with a circle around it) is displayed on movies to provide feedback to the user that they are
paused.

4.7 Caching and Filters

Click on the "Caching & Filters" tab in the settings dialog to change the settings for caching and
filtering:
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Caching

Photos displayed by Breeze Kiosk are cached in memory (RAM) to improve performance. If the
computer has insufficient RAM to hold all the photos it may cause Breeze Kiosk to run slowly. If this is
a problem please try reducing the sizes of the image caches. When the cache becomes full older
images that haven't been viewed for a while will be removed from the cache to free up memory.
Click on "Add thumbnails to cache when Kiosk is idle" to automatically cache thumbnails in the
background when Kiosk is idle. Thumbnails will be added to the thumbnail cache (up to the specified
cache size) to improve performance when new images are selected.

Filtering

Filtering provides a way to only display certain images that match a pattern. The filter is in the form of a
regular expression that is used to match the full pathname of an image.

This is useful for applications where privacy is important and users are only allowed to view their own
photos.

Example
One way to use this is by scanning a QR code that contains a code to identify the user's photos e.g.
photos taken by a photo booth running DSLR Remote Pro that have the filename set to a unique
identifier using the {uid} or {uid2} tokens. If the prints from the photo booth include a QR code with the
unique identifier this could be scanned using a QR code reader and used to set the filename filter in
Breeze Kiosk.

1. Setup DSLR Remote Pro to use the {uid2} token as the prefix for filenames. This will add a unique
identifier to each set of photos.

2. Add a QR code that includes the {uid2} token to the print output e.g. set the QR code text to https://
breezesys.com?s1={uid2}

3. Use the Webcam QR Code scanner to scan the QR code and link it to Breeze Kiosk. When the QR
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code is scanned the unique id will be read from the s1 parameter in the QR code text and will be
available using the {qr1} token

4. Set the pathname filter only match filenames that start with the unique id e.g. .*{qr1}.*

The regular expression .*{qr1}.* looks for a pathname that starts with any string (the first .*) followed by
the unique id (which is read using the {qr1} token) followed by any string.

The above example does have one a flaw which is Breeze Kiosk will continue to display the last user's
photos until the next user scans their code. Ideally after a suitable timeout the kiosk should display a
screen inviting the next user to scan their code. This can be done by enabling a slideshow after an
inactivity timeout. Before displaying the slideshow Breeze Kiosk will clear any QR code strings causing
the {qr1} token to return an empty string.
The {if} token can be used to detect the empty string and replace it with a string that won't match any
files e.g. {if,{qr1},{qr1},NO MATCH}
Replace the pathname filter with .*{if,{qr1},{qr1},NO MATCH}.*
Now when the QR code is scanned {qr1} will contain the unique id, the {if} token will return the unique
id because {qr1} isn't empty and the pathname filter becomes .*{qr1}.*
After the inactivity timeout the slideshow starts running and the {qr1} token is cleared. The {if} token
now returns NO MATCH and the pathname filter becomes .*NO MATCH.* which will only match
pathnames that contain NO MATCH.
If a no_images_background.jpg screen image is found in the screen images folder this will be
displayed when the pathname filter doesn't match any images. This screen image can be used to
prompt the next user to scan their QR code. 

The following website is useful for testing regular expressions: https://regex101.com/

4.8 QR Codes and Contactless Sharing

QR codes can be displayed on the screen to provide a quick way for guests to visit your website or
online gallery simply by scanning the QR code with their phone (see Display Settings).

QR codes can also be used for sending information to Breeze Kiosk such as email addresses. This
allows a QR code to be used to share images (photos, GIFs and videos) via email without the user
needing to touch the kiosk.

A QR code can also contain a string which can be read by Breeze Kiosk using tokens. When this is
combined with the filtering option it provides a way for users to view their images by scanning a QR
code. This method enhances privacy by only allowing guests to see their images by scanning their QR
code. They won't be able to see images of other guests and their images won't be visible to other
guests.

QR codes are read using a webcam and the Webcam QR Code Scanner utility that comes with
Breeze Kiosk.

Contactless Sharing

QR codes can be generated on a user's phone to control a photo booth using our DSLR Remote Pro
or Breeze Booth for iPad photo booth software. The same QR codes can also be used to email images
from Breeze Kiosk.
The QR codes can be created using the QR code generator on the website contactlessbooth.com.
Please see this page for information customizing the QR code generator.
Alternatively you can create a QR code generator on your own website using Wordpress plug-ins or
scripts such as this sample PHP script.

Another option is to add a QR code with a unique id to the prints from the photo booth. The user then
scans the QR code on the print to view their photos in Breeze Kiosk.

https://regex101.com/
https://contactlessbooth.com
https://contactlessbooth.com/qr
https://contactlessbooth.com/qr/script.php
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Scanning QR Codes

Breeze Kiosk is able to accept QR codes scanned using  the Webcam QR Code Scanner utility that
comes with Breeze Kiosk. QR codes can be used to scan in information such as names, unique ids or
email addresses.

QR codes should be defined as URLs with the strings defined as percent encoded parameters.

Scanning strings
Up to 10 strings can be defined in the URL by naming the parameters s1, s2, s3 etc. The URL below
gives and example with s1 set to "John" and s2 set to "Doe":
https://example.com?s1=John&s2=Doe
These strings can be accessed using tokens e.g. {qr1} for s1, {qr2} for s2 etc. One way to use these
tokens is to select a user's images using the filter option.
The parameters should be percent encoded e.g. to define a single parameter that includes two words
separated by a space the space is encoded as %20 e.g.
https://example.com?s1=John%20Doe

Previously scanned QR tokens are cleared when a new QR code is scanned or when a slideshow is
displayed after a period of inactivity.

Scanning email addresses
Email addresses can be scanned when the display is showing the main image (e.g. when using the
"Thumbnails and photo" or "No thumbnails" options). An email address can also be scanned in when
Breeze Kiosk is running a slideshow. This will exit the slideshow and send email the last image that
was displayed in the slideshow.

The QR code can be used to send an email to a single email address with one or more optional CC
email addresses. The parameters for email addresses are:
email - sends an if the QR code is scanned when a main image is displayed or a slideshow is running
autoemail - the same as the 'email' command (autoemail is used by DSLR Remote Pro when running
a contactless photo booth).
cc - a CC email address

Example: Send an email to techsupport@breezesys.com and CC it to sales@breezesys.com
https://breezesys.com/qr.php?email=techsupport%40breezesys.com&cc=sales%40breezesys.com

Webcam QR Code Scanner

The Webcam QR Code Scanner which allows a webcam to be used to scan QR codes for the kiosk. It
can display a live feed from the webcam on the screen to help people position their phone when
scanning a QR code. You can specify the size and position of the live feed and when it is displayed
using the app's settings.
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Select the webcam from the "Camera:" dropdown list and then set the resolution and rotation as
required. The resolution does not need to be set to the highest setting to scan QR codes successfully.
A lower resolution setting should work well and may provide a faster live view refresh rate.

Click on the "Settings..." button to adjust the settings:

Use the left, top, width and height settings to specify the size and position of the live view window on
the screen.

Select "Display debug info" to display debug info in the live view window. This includes the size and
position of the live view window and the text scanned in from QR codes.
When debug info is selected you can adjust the position of the live view window by dragging it with the
mouse.

Select the "Auto run" option to start displaying the live view window automatically when the photo booth
runs in full screen mode.

Select the "Auto hide" option to automatically hide the live view window when sending an email..

Set "Link to:" to Breeze Kiosk to use the Webcam QR Code Scanner utility with a Breeze Kiosk.
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Sending Commands from other Apps

The Webcam QR Code Scanner utility passes the scanned URL to Breeze Kiosk by sending a
WM_COPYDATA message with the data type (dwData) set to 200. Other apps can also use this
technique to send strings and email commands to Breeze Kiosk. Please note that the QR code string
must be in the form of a URL.

5 Touchscreen Keyboard

The touchscreen keyboard is automatically displayed when the user needs to type in some text such
as their email address when sending emails or their Twitter username and password when posting
photos Twitter. Breeze Kiosk provides default keyboard layouts for email address entry, Twitter
username and password and for entering the password when exiting full screen kiosk mode.

The touchscreen keyboards used for email addresses or Twitter login details can be tested by
pressing the "Test keyboard..." buttons in the general section of Breeze Kiosk's preferences. The
default keyboard layout for email addresses will fill the screen and look similar to the screenshot
below:

Customizing the keyboard
The layout of the keyboard can be customized by creating an XML settings file called keyboard.xml
and putting this in the photo booth images folder. This gives control over the size and position of the
keys, the background color etc. A series of keyboard images can also be used if you need more
control of the appearance of the keyboard.

The easiest way to customize the keyboard is to save a copy of the XML file and TIFF screen images
used to define the default keyboard layout and then edit them as required. The files can be saved by
first displaying the keyboard by pressing the "Test keyboard..." button and then holding down both the
Shift and Ctrl keys and pressing the left mouse button. The keyboard.xml file will look something like:

<?xml version="1.0" ?>
<breeze_systems_photobooth version="2.2">
<photobooth_settings>
  <keyboard>
    <text_point_size>480</text_point_size>
    <prompt1>Please enter your email address:</prompt1>
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    <text1_y>411</text1_y>
    <text1_x>50</text1_x>
    <text1_w>300</text1_w>
    <background_color>0x000080</background_color>
    <transparent_color>0x000080</transparent_color>
    <text_color>0xFFFFFF</text_color>
    <show_cursor>0</show_cursor>
    <show_mouse_cursor>0</show_mouse_cursor>
    <key>
      <left>58</left>
      <top>630</top>
      <width>112</width>
      <height>89</height>
      <legend>q</legend>
      <shifted_legend>Q</shifted_legend>
      <code>q</code>
      <shifted_code>Q</shifted_code>
    </key>
    <key>
      <left>186</left>
      <top>630</top>
      <width>112</width>
      <height>89</height>
      <legend>w</legend>
      <shifted_legend>W</shifted_legend>
      <code>w</code>
    </key>
    ...
    <key>
      <left>1296</left>
      <top>840</top>
      <width>160</width>
      <height>89</height>
      <legend>Shift</legend>
      <shifted_legend>Shift</shifted_legend>
      <code>Shift</code>
      <shifted_code>Shift</shifted_code>
    </key>
    <key>
      <left>400</left>
      <top>945</top>
      <width>368</width>
      <height>89</height>
      <legend>Send email</legend>
      <shifted_legend>Send email</shifted_legend>
      <code>OK</code>
      <shifted_code>OK</shifted_code>
    </key>
    <key>
      <left>784</left>
      <top>945</top>
      <width>368</width>
      <height>89</height>
      <legend>No thanks!</legend>
      <shifted_legend>No thanks!</shifted_legend>
      <code>Cancel</code>
      <shifted_code>Cancel</shifted_code>
    </key>
  </keyboard>
</photobooth_settings>
</breeze_systems_photobooth>

Text input
The <prompt1> tag defines the text that is displayed above the user input area and defaults to "Please
enter your email address:". The <text1_x> and <text1_y> tags specify the position of the user input
area. This is specified as the number of pixels down from the top, left corner of the screen. The width
in pixels of the user input area can be specified using the <text1_w> tag.
Additional prompts can be added by including <prompt2>, <text2_x>, <text2_y>, <text2_w> etc. tags
up to a maximum of 10 user input areas.
The prompt tags can have an optional password attribute which if set to "1" will display the text in the
user input area as * characters e.g. <prompt1 password="1">Please enter your password:</prompt1>.
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The prompt tags can have an optional email_address attribute which if set to "1" will check that the text
looks like an email address in the form name@domain.com e.g. <prompt1 email_address="1">Please
enter your email address:</prompt1>. If the text does not appear to be an email address an error
message will be displayed. CC addresses can be entered when emailing images by defining multiple
prompts with the email_address attribute. The first prompt containing an email address will be used as
the main "To" address and any additional prompts containing email addresses will be used as CC
addresses.

When more than one user input area is defined users can switch between the input areas by touching
them. The currently selected input area is highlighted in red.

The optional <text_point_size> tag defines the size of the text font used in the user input area. This is
specified in tenths of a point and defaults to 480 (a point size of 48).
The text entered by the user is stored in the <user_data>, <user2_data> etc. fields in the XML file
saved with the photos.

Checkboxes
Up to 10 checkboxes can be added using the <chkbox1_prompt>, <chkbox1_x>, <chkbox1_y>,
<chkbox2_prompt>, <chkbox2_x>, <chkbox2_y> etc. tags. The <chkbox1_prompt> tag specifies the
text displayed to the right of the text box and can include a value attribute to specify whether the
checkbox is initially checked or not e.g. <chkbox1_prompt value="0">Checkbox prompt (default off)</
chkbox1_prompt> or <chkbox1_prompt value="1">Checkbox prompt (default on)</chkbox1_prompt>.
A checkbox can also be made mandatory (i.e. the user has to check the checkbox before pressing the
"OK" button) by adding the mandatory attribute to the <chkbox1_prompt> tag e.g. <chkbox1_prompt
mandatory="1">I agree to the terms and conditions</chkbox1_prompt>.
The optional point_size attribute can be used to specify the point size of the legend and also the size of
the checkbox box e.g. <chkbox1_prompt point-size="240">Checkbox</chkbox1_prompt> adds a
checkbox with the legend displayed using 24 point text.
The <chkbox1_x> and <chkbox1_y> tags specify the position of the checkbox.
The checkbox status is stored in the <chkbox1>, <chkbox2> etc. fields in the XML file saved with the
photos.

Adding an Information Page
An optional information page can be displayed to provide more information to the user e.g. a privacy
policy or help information.
To add an information page create a JPEG or TIFF screen image with the same name as the
keyboard.xml file e.g. email_keyboard_info.jpg. This can be displayed by defining a key with the code
"info". The info screen will close automatically after a timeout of 30 secs. It can be closed manually by
defining a key with the code "info close" and tapping on it.

Color and Other Settings
The <background_color> tag specifies the background color of the window and the <key_text_color>
specifies the color for the prompt text and key legends.
The optional <text_foreground_color> tag specifies the foreground color for text displayed in the user
input areas. The default value if this tag is omitted is black (0x000000).
The optional <text_background_color> tag specifies the background color for the user input areas. The
default value if this tag is omitted is white (0xFFFFFF).
The optional <transparent_color> tag specifies a color which will be made transparent when the
keyboard is displayed.
All colors should be hexadecimal RGB values e.g. 0x000000 for black, 0xFF0000 for red, 0x00FF00
for green, 0x0000FF for blue, 0xFFFFFF for white.

The <show_cursor> tag specifies whether a gray cursor is shown in the user input area. Set this to 1 to
display the cursor or 0 to hide it. The cursor display is useful if the keyboard allows the entry of spaces.
The <show_mouse_cursor> tag specifies whether a the mouse cursor is displayed, The default setting
is for the mouse cursor not to be displayed.
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The <key> tag specifies the size and position of each key, its legends and what should be typed when
it is pressed. The top left corner of the key is defined using the <left> and <top> tags and the width and
height are specified using the <width> and <height> tags (all values are in pixels). The
<shifted_legend> tag specifies what is displayed on the key when the shift key is pressed and the
<legend> specifies the key legend when shift is not pressed. 
The <shifted_code> tag specifies what is typed when the key is pressed when shift is pressed and the
<code> tag specifies what is typed when the shift key is not pressed. The following codes have special
values:
"Shift" - puts the keyboard into shifted mode (i.e. upper case) when pressed
"info" - display the optional info screen if defined
"info close" - close the optional info screen and return to the touchscreen keyboard
"OK" - closes the keyboard window and returns the user input if at least one text input field contains
text
"OK all" - closes the keyboard window and returns the user input if all the input fields contain some text
"OK none" - closes the keyboard window and returns the user input even if none of the input fields
contain text
"Cancel" - closes the keyboard window and cancels the user input

Entering non-ASCII International Characters
International characters can be added by using the character's unicode value e.g. the Euro currency
symbol € is represented by the unicode character U+20AC and should be added to the XML file as
&#x20AC; as shown in the example below:
    <key>
      <left>58</left>
      <top>630</top>
      <width>112</width>
      <height>89</height>
      <legend>2</legend>
      <shifted_legend>&#x20AC;</shifted_legend>
      <code>2</code>
      <shifted_code>&#x20AC;</shifted_code>
    </key>

The keyboard.xml can just include additional settings and the touchscreen keyboard will use the
default layout (shown above) if it doesn't contain any <key> tags. For example you could use the
default keyboard layout and add a checkbox to ask users whether they consent to their photos being
uploaded to a website using the keyboard.xml file below:

<?xml version="1.0" ?>
<breeze_systems_photobooth version="2.3">
<photobooth_settings>
  <keyboard>
    <chkbox1_prompt value="0">I agree to my photos being posted on a web site</chkbox1_prompt>
    <chkbox1_x>38</chkbox1_x>
    <chkbox1_y>70</chkbox1_y>
  </keyboard>
</photobooth_settings>
</breeze_systems_photobooth>

When the Twitter upload option is used the touchscreen keyboard will look for a definition file named
twitter_keyboard.xml instead of keyboard.xml. If the twitter_keyboard.xml file is not found the
touchscreen keyboard will display two input areas to allow users to enter their Twitter username and
password.

Keyboard images
Separate keyboard screen images can be defined if you need more control over the appearance of the
keyboard. These images should be TIFF images the same size as the resolution of the screen and
should be placed in the photo booth images folder. The default keyboard images should be named as
follows:

keyboard_uppercase.tif - keyboard image showing upper case key legends
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keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with the keys
pressed
keyboard_lowercase.tif - keyboard image showing lower case key legends
keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the keys
pressed

If TIFF keyboard images aren't found the software will attempt to load JPEG images instead
(keyboard_uppercase.jpg, keyboard_uppercase_pressed.jpg, keyboard_lowercase.jpg and
keyboard_lowercase_pressed.jpg).

When the email option is used the touchscreen keyboard will look for the following keyboard xml
definition file and keyboard images:
email_keyboard.xml - XML file defining the keyboard layout
email_keyboard_uppercase.tif - keyboard image showing upper case key legends
email_keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with the
keys pressed
email_keyboard_lowercase.tif - keyboard image showing lower case key legends
email_keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the
keys pressed

When the SMS option is used the touchscreen keyboard will look for the following keyboard xml
definition file and keyboard images:
sms_keyboard.xml - XML file defining the keyboard layout
sms_keyboard_uppercase.tif - keyboard image showing upper case key legends
sms_keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with the
keys pressed
sms_keyboard_lowercase.tif - keyboard image showing lower case key legends
sms_keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the keys
pressed

When the MMS option is used the touchscreen keyboard will look for the following keyboard xml
definition file and keyboard images:
mms_keyboard.xml - XML file defining the keyboard layout
mms_keyboard_uppercase.tif - keyboard image showing upper case key legends
mms_keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with the
keys pressed
mms_keyboard_lowercase.tif - keyboard image showing lower case key legends
mms_keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the
keys pressed

When the Twitter upload option is used the touchscreen keyboard will look for the following keyboard
xml definition file and keyboard images:
twitter_keyboard.xml - XML file defining the keyboard layout
twitter_keyboard_uppercase.tif - keyboard image showing upper case key legends
twitter_keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with the
keys pressed
twitter_keyboard_lowercase.tif - keyboard image showing lower case key legends
twitter_keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the
keys pressed

If a password is required when exiting full screen mode the touchscreen keyboard will look for the
following keyboard xml definition file and keyboard images:
password_keyboard.xml - XML file defining the keyboard layout
password_keyboard_uppercase.tif - keyboard image showing upper case key legends
password_keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with
the keys pressed
password_keyboard_lowercase.tif - keyboard image showing lower case key legends
password_keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the
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keys pressed

If the "Ask for email address before printing" option is selected the touchscreen keyboard will look for
the following keyboard xml definition file and keyboard images:
print_keyboard.xml - XML file defining the keyboard layout
print_keyboard_uppercase.tif - keyboard image showing upper case key legends
print_keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with the
keys pressed
print_keyboard_lowercase.tif - keyboard image showing lower case key legends
print_keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the keys
pressed

When privacy mode is selected the touchscreen keyboard will look for the following keyboard xml
definition file and keyboard images when asking for the code:
privacy_keyboard.xml - XML file defining the keyboard layout
privacy_keyboard_uppercase.tif - keyboard image showing upper case key legends
privacy_keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with the
keys pressed
privacy_keyboard_lowercase.tif - keyboard image showing lower case key legends
privacy_keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the
keys pressed

Please take care that the keys are in the same positions in each of the keyboard images and that
these also correspond to the values in the keyboard.xml file. The <background_color>, <text_color>,
<prompt>, <legend> and <shifted_legend> tags in the keyboard.xml file are ignored when keyboard
images are used to define the appearance of the keyboard.

Note: If you only need to change the keyboard layout and are happy with the default keyboard display
you only need to create a keyboard.xml file in the photo booth images folder and can delete the
keyboard screen images (keyboard_uppercase.tif, keyboard_uppercase_pressed.tif,
keyboard_lowercase.tif and keyboard_lowercase_pressed.tif). If keyboard images are defined the
<prompt> tags in the keyboard.xml file will be ignored.

6 Signing or Drawing on Photos

Users can sign the photo, draw on it, add frames or emojis/stickers by tapping on the drawing icon in
the main Breeze Kiosk window. The edited image is saved as a new JPEG image displayed in the
main Breeze Kiosk screen.

The photo is displayed full screen with a menubar down the left hand side. The current line width and
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pen color is displayed in the top left hand corner. Users can sign their print or draw on it using a
touchscreen or mouse. Tapping the color palette icon in the menubar will display a panel of colors
allowing users to choose the pen color:

When the user taps on a color in the panel it is highlighted and the pen width and color indicator in the
top left corner is updated to show the color. The color panel can be dismissed by tapping anywhere in
the menubar or by drawing on the print.
Tapping the line width icon in the menu bar will display a slider allowing users to adjust the line width: 

The pen width can be adjusted by moving the slider left or right and the pen width and color indicator in
the top left corner is updated to show the new pen width. The pen width slider can be dismissed by
tapping anywhere in the menubar or by drawing on the print.
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Users can add emojis/stickers/virtual props by clicking on the emoji icon in the menu and then
selecting the required image. The image is placed in the center of the print preview and can be moved
by dragging the center and resized or rotated the image by dragging the corners. Tap outside the
image to fix it. The emoji can be removed by tapping the undo button.

If the user makes a mistake they can undo the last action by tapping the "Undo" icon (the red arrow in
the menubar). Alternatively they can start again by tapping the trashcan icon. Actions that have been
undone by tapping on the undo or trashcan icons can be re-done by tapping the "Redo" icon (the blue
arrow in the menubar).

Tapping the accept icon accepts the the photos together with any drawing added by the user and
saves a new JPEG image which can be shared or printed from the main Breeze Kiosk screen..

Tapping on the cancel icon (the cross at the bottom of the menubar) will cancel the edits without
saving a copy and returns to the main Breeze Kiosk screen.

Modifying the appearance of the screen

The default screen appearance is a black background with a white menubar area. The icons for the
actions in the menubar a defined using PNG files in the icons subfolder of in the installation folder:
color.png - image used for the color palette icon
width.png - image used for the pen width icon
emoji.png - image used for the emoji icon
frames.png - image used for the frames icon
redo.png - image used for "Redo" icon
undo.png - image used for the "Undo" icon
clear.png - image used for the clear/trashcan icon
accept.png - image used for the accept icon
cancel.png - image used for the cancel icon

The appearance of the icons can be changed by replacing the PNG images in the icons subfolder with
new images or by placing PNG images in the current photobooth images folder.

The appearance of the whole screen can be modified by creating a JPEG screen image named
usermodifyprint.jpg and placing it in the current photobooth images folder. The screen image should
be the same size in pixels as the screen on which the photo booth will be displayed.

An optional overlay can be placed on top of the background and print layout by creating a PNG screen
image named usermodifyprint_overlay.png and placing it in the current photobooth images folder. The
overlay image should be the same size in pixels as the screen on which the photo booth will be
displayed and should contain transparency information in the alpha channel. The overlay can be used
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to display instructions to the user and will appear on screen but not in the final prints.

A set of color icons is available in the "color icons" subfolder of the installation folder:

These can be used by renaming the "icons" subfolder to "b&w icons" and renaming the "color icons"
subfolder to "icons" in the installation folder. Alternatively the icon PNG files can be copied into the
current photo booth images folder. 

Editing the settings

Hold down the shift and ctrl keys and left click the mouse to display the settings dialog:

Use the checkboxes in the "Menu Items" area to select which actions should be made available to the
user in the menubar area.

Select "Enable line drawing" if you want users to be able to draw on the print. Disable "Enable line
drawing" if you only want users to be able to add emojis or frames.

The initial color setting specifies the pen color that is selected when the screen is displayed. Click on
the "..." button to choose a different color.
The initial line width specifies the line width in pixels of the pen when the screen is first displayed. The
min line width and max line width settings specify the range of line widths the user can select if the
"Line width selector" menu option is enabled.
Select "Automatically close color selector when user selects color" to close the color selector menu
when a color is selected.

By default the emoji and frame menus have a white background. Select "Use gray background for
emoji and frame menus" to use a mid-gray background instead. This is useful if the emojis or frames
have light colors which don't show up well against a white background.

Select "Automatically close frame selector when user selects a frame" to close the frame selector
menu when a frame is selected. If this option is not selected the frame selector menu will continue to
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be displayed when a frame is selected and the print preview is updated to show the selected frame.

Select "Default to first frame" to add the first frame to the print layout when opening the drawing/
signing screen.

The "Inactivity timeout (secs):" setting allows a timeout to be set. If the user does not touch the screen
for a period longer than the timeout value the screen will be closed and the photos either printed or
canceled depending on the timeout action setting. Setting the timeout to 0 will disable the timeout.

Select "Emojis" to add the option to add emojis/stickers/virtual props to prints and specify the folder
where the emoji images are stored in "Emoji folder:". The images should be PNG images with an
optional alpha channel for transparency information. The recommended image size for the emoji
images is between 128x128 pixels and 1024x1024 pixels.
The folder name can be a relative path (e.g. "emoji") to use images in a subfolder or an absolute path
(e.g. C:\emoji_images) if they are stored elsewhere. If it is set to a relative path it looks for the
subfolder in the current photo booth images folder first and then looks in the installation folder. This
allows different sets of emojis to be made available for each profile if required.
Emoji icons supplied by EmojiOne

The position of the photo preview can be adjusted using the "Preview position:" dropdown. The default
setting is to center it vertically. Select the "Top" option to place the preview at the top of the screen or
"Bottom" to place it at the bottom of the screen.

By default users can draw anywhere on the photo, but this can be limited by enabling the clipping and
exclusion clipping regions. The clipping region is used to specify a region where the user is allowed to
draw. The exclusion region allows an area within the drawing area to be protected e.g. to stop people
drawing on corporate logos. The clipping and exclusion clipping regions can be edited by clicking on
the "OK" button. The clipping region will be displayed by a green rectangle and the exclusion clipping
region by a red rectangle. Click on one of the rectangles to select it and then adjust its size and
position by dragging it corners. Click in the menubar area to save the settings and return to drawing
mode.

Select the "Show mouse cursor" to display the mouse cursor to allow users to draw on the photos
using a mouse.

Frames

The frames option allows users to choose a frame to apply to the photo. The frames are defined by
overlay PNG images in the current photo booth images folder with filenames starting with frame_ e.g.
frame_1.png, frame_2.png etc. The frame overlays are sorted into alphabetical order when they are
displayed in the frame selector menu.
The frames menu icon will only be displayed if the "Frames" option is selected in the settings and one
or more frame overlay images are found in the current photo booth images folder.

The frame overlay images should be the same size in pixels as the photo and have transparent areas
where the photos are positioned so that the photos can be seen underneath the frame overlay.
Please note: The frame overlay may obscure them captions and logos added by the photo booth
software that created the print layout. If you wish to add a logo or caption to the  photos and use the
frames option in the drawing/signing screen you either need to leave transparent areas in frames or to
add the logos or captions to each of the frame overlay images.

Implementation notes

The signing and drawing screen is implemented using a dynamic library named UserModifyPrint.dll
and saves its settings in the Windows registry using the following registry key:
HKEY_CURRENT_USER\SOFTWARE\BreezeSystems\BreezeKiosk\100\UserModifyPrint
If different drawing and signing functionality is required it can be implemented by creating a new

https://www.emojione.com
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dynamic library to replace the default UserModifyPrint.dll library without requiring a custom build of
BreezeKiosk.

Copyright information for icons used by UserModifyPrint.dll:
Undo/Redo/Cancel/Accept/Frames icons: These icons are provided by icons8 as Creative Commons
Attribution-NoDerivs 3.0. You can copy, use and distribute this icon, even for commercial purposes, all
without asking permission provided you link to icons8.com website from any page you use this icon.
You may not alter, transform, or build upon this work. https://icons8.com
Color Palette/Trashcan icons from http://downloadicons.net
Printer icon: royalty free icon purchased from http://artistsvalley.com. This icon may only be used with
Breeze Systems' products unless a separate license is purchased from Artists Valey. 
Line width: Copyright Breeze Systems Limited. This icon may only be used with Breeze Systems'
products.

7 Animated GIFs and MP4 Movies

Animated GIFs are a fun way to present images from a photo booth and are supported in Breeze
Kiosk v2.2 onwards. Animated GIFs are animated in the main image and slideshow views. To avoid
too many distracting moving images animated GIFs are not animated in the thumbnail display and only
show the first frame of the animation.

The latest versions of Breeze Systems' DSLR Remote Pro photo booth software can capture animated
GIFs and MP4 video files.

There are a number of things to bear in mind when using animated GIFs or MP4 movies:

1. Automatic looping - the main advantages of animated GIFs are that they can be displayed in a
continuous loop and are supported by almost all email clients, web browsers etc. MP4 movie files
don't loop automatically but some social sharing sites (e.g. Facebook and Instagram) will display
them in a continuous loop.

2. File Size - GIF files use lossless compression which results in larger file sizes than other image
formats that use lossy compression such as JPEG. This can be an issue if you only have a slow
internet connection because it may take a long time to upload the image files. File size can also be a
problem when using some services such as MMS which usually limits the maximum file size to
300KB or 600KB.
MP4 files use lossly compression which gives much smaller file sizes (typically 1/20 the size of the
equivalent animated GIF) with little loss of quality.

3. Color Limitations - GIF images are limited to a palette of 256 colors per frame which can result in
poor rendition of color photos. Compare this with JPEG which can have more than 16 million
different colors and it is clear that there will be some reduction in quality when converting a series of
JPEG images to an animated GIF.
MP4 files don't have any color limitations and can display full 24-bit color images.

4. Twitter Limitations - Twitter supports the direct uploading of animated GIFs to a Twitter feed but
when Twitter receives the GIF it converts it into an MP4 movie file and then plays it back in a looping
player when viewed on a web page. This can result in a loss in quality and so you may need to
experiment with different image and file sizes to get the best results.
MP4 files can be uploaded to a user's Twitter feed but won't play in a continuous loop.

5. MMS/SMS Limitations when using Twilio - Twilio may resize an animated GIF to conform with
MMS file size limits (usually 300KB or 600KB) and this may cause the animated GIF to fail to play
back properly. Whether an animated GIF sent as an MMS is displayed properly may also depend on
the user's cellphone. Sending an animated GIF as an SMS message with a link to where it is hosted
on a separate website allows file sizes of up to 1MB. Most smartphones will display the animated

https://icons8.com
http://downloadicons.net
http://artistsvalley.com
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GIF in a web browser when the user clicks on the link in the SMS message. However, please note
that link to the animated GIF will only be valid for 7 days after sending the SMS message.
MP4 files have the advantage that the file size is much smaller than animated GIFs, but won't
displayed in a continuous loop when viewed on the user's phone.

6. Email - animated GIFs can be sent as email attachments with no size limit other than time it takes
to upload the data. Most email clients on PCs, tablets and smartphones should display the animated
GIF correctly. To make the sending of emails quicker you can choose not to send the image file or
animated GIF as an email attachment but to send a link to the image hosted on a separate website
instead. For this to work you need to upload the animated GIF to a separate website. One way to do
this is to use the offline email mode and then after the event upload the photos to your website
before sending the emails.
MP4 files have the advantage that the file size is much smaller than animated GIFs, but won't
displayed in a continuous loop when the email is viewed. There isn't a standard way to embed an
MP4 file in an HTML email message - the <img> tag can only be used for JPEG and GIF images
and the HTML5 <video> tag isn't supported by most email clients. Most email clients will handle the
video as a file attachment.

8 Payment Options

Breeze Kiosk v2.1 onwards supports payments using standard payment systems such as the Nayak
VPOS Touch contactless credit card reader (shown below). To use this you need to run our free MDB
Payment utility software and to buy the necessary hardware (a Qibixx MDB-USB Interface, PSU and
cables and a suitable MDB payment system such as the Nayax VPOS Touch).

The MDB Payment utility monitors the state of the kiosk by reading the pathname of the screen being
displayed and communicates with any suitable MDB payment system via the Qibixx MDB-USB
interface.
MDB is a standard interface used by the vending machine industry to connect a wide range of payment
systems to vending machines (or in this case a photo booth). A typical payment system for a Windows
based kiosk is shown below:
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For more information please see the help file for the MDB Payment Utility.
The MDB Payment Utility can be downloaded from the Downloads & Support page on our website.

Alternative Payment Systems

Payments can also be accepted when the print payment screen is displayed by sending a F6 key press
the Breeze Kiosk. To use this option you need to interface a payment system to the computer which
monitors the screen displayed by Breeze Kiosk and sends F6 to Breeze Kiosk when a payment has
been accepted.

Screens/Workflow

When the maximum number of print copies the user can select is set to more than one the workflow is:
1. User taps the printer icon in the main screen and the print screen (print.jpg) is displayed with +/-

buttons to select the number of prints.
2. Tapping on the +/- buttons will increase or decrease the number of copies displayed in the print

screen.
3. If the user taps the cancel button or doesn't tap the screen and the print timeout occurs the printing

is cancelled and the main screen is displayed.
4. If the user taps the print button in the printing screen the print payment screen is displayed. The

filename of the screen image displayed for print payment screen includes the number of copies
selected by the user e.g. print_payment1.jpg, print_payment2.jpg, print_payment3.jpg etc.

5. When the print payment screen is displayed Breeze Kiosk waits for the payment to be accepted
(either a "Payment accepted" command from the MDB Payment Utility or a F6 key press) before

https://breezesys.com/MDBPayment/help/
https://www.breezesys.com/support/
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printing. If the print timeout occurs before the payment is made or the user taps cancel the printing
is cancelled and the main screen is displayed.

When the maximum number of print copies the user can select is set to one the workflow is similar to
above but skips the print screen because the user can't select the number of copies to print:
1. User taps the printer icon in the main screen and the print payment screen is displayed

(print_payment.jpg).
2. When the print payment screen is displayed Breeze Kiosk waits for the payment to be accepted

(either a "Payment accepted" command from the MDB Payment Utility or a F6 key press) before
printing. If the print timeout occurs before the payment is made or the user taps cancel the printing
is cancelled and the main screen is displayed.

9 Event Info

Event information can be defined and used in messages used when sharing photos or for specifying
the folder to be monitored for images. The information is saved in the Windows registry so that it may
be shared with other applications and is read from the Windows registry before it is used so that it can
use information supplied by other applications. The "Photo Booth Event Info" dialog can be displayed
by selecting "Event info..." from the File menu:
 

The event info can be used in filenames (e.g. the filename and download folder of photos downloaded
from the camera), caption text in print layouts or in the message text used when sharing photos by
using the tokens below. The information is also saved in the Windows registry using the registry key:
HKEY_CURRENT_USER\Software\BreezeSystems\Event Info.

Item Token Registry value

Event name {eventName} HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventName

Event string 1 {eventString1} HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventString1

Event string 2 {eventString2} HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventString2

Event string 3 {eventString3} HKEY_CURRENT_USER\Software\BreezeSystems\Event
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Info\EventString3

Event string 4 {eventString4} HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventString4

Event string 5 {eventString5} HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventString5

Print counter none HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\PrintCounter

Breeze Kiosk
print counter

none HKEY_CURRENT_USER\Software\BreezeSystems\BreezeKi
osk\100\PrintCounter

Two print counters are available:
1. "Print counter" - this is a print counter shared via the Windows registry with other apps (e.g. DSLR

Remote Pro) and is decremented each time any app prints a photo
2. "Breeze Kiosk print counter" - this is a private print counter only used by Breeze Kiosk. The counter

is decremented each time a photo is printed.

Print and Sharing Totals

The print and sharing totals shown at the bottom of the "Photo Booth Event Info" keep a count of the
total number of prints made by and emails, texts and tweets sent by Breeze Kiosk. These counters are
incremented each time a photo is printed or shared. The counters can be reset by entering new values
and pressing "OK".
The counters are saved to the Windows registry when they are updated so that they can be monitored
by other applications if required.

Counter Registry value

Prints HKEY_CURRENT_USER\Software\BreezeSystems\BreezeKi
osk\100\TotalPrintCounter

Emails HKEY_CURRENT_USER\Software\BreezeSystems\BreezeKi
osk\100\EmailCounter

Texts HKEY_CURRENT_USER\Software\BreezeSystems\BreezeKi
osk\100\TextCounter

Tweets HKEY_CURRENT_USER\Software\BreezeSystems\BreezeKi
osk\100\TweetCounter

10 Automatically Uploading Photos to a Website

To display animated GIFs on Facebook or in an email which contains a link to the image instead of an
attachment you need to upload the photos to a website and provide the URL in the message text.
Many FTP clients have the option to automatically sync the contents of a folder on the local PC with a
folder on a remote server using FTP. Two free options are FTPbox and GoodSync. There are too
many commercially available syncing FTP clients to list here, but one simple to use option is NetDrive
which allows you to mount a folder from a remote computer as a Windows drive.
WARNING: Please take great care when automatically syncing folders to a remote server to ensure
you don't accidentally erase important files from your webserver or compromise your website's
security.

Example: Setup a syncing FTP client to sync the contents of the prints folder from a photo booth with a
folder on your webserver and then email a link to the image on the webserver.

http://ftpbox.org/
http://www.goodsync.com
http://www.netdrive.net/
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Folder on the PC: C:\users\Chris\PhotoboothImages\2015-11-10\prints
URL of remote folder on webserver: http://www.breezesys.com/photos
When the photobooth software prints the photos it saves a JPEG copy of the print output on the prints
folder (C:\users\Chris\PhotoboothImages\2015-11-10\prints) and the syncing FTP client will
automatically upload it to the photos folder on the webserver. If the JPEG filename is
20151101_223012.jpg the URL of the image on the webserver will be http://www.breezesys.com/
photos/20151101_223012.jpg
A link to the photo can be included in the email by using the {fullFilename} token which returns the full
filename of the image without the folder i.e. 20151101_223012.jpg
The HTML email text needs to be set to something like this:

<html><body>
<p><b>Your photo booth photos taken on %L</b></p>
<p><img src="http://www.breezesys.com/photos/{fullFilename}"></p>
</body></html>

When the email is sent this will be converted to:

<html><body>
<p><b>Your photo booth photos taken on Tuesday, November 10, 2015</b></p>
<p><img src="http://www.breezesys.com/photos/20151101_223012.jpg"></p>
</body></html>

11 Instagram Hashtag Printer Example

An Instagram hashtag printing system can be created using Breeze Kiosk and Hotfolder Prints (which
must be purchased separately). The Hotfolder Prints package provides a hashtag monitor which
downloads photos with a given hashtag from Instagram and Hotfolder Prints which formats the
downloaded photos into a form suitable for viewing and printing using Breeze Kiosk.

First setup Hotfolder Prints to monitor the folder where the photos are downloaded so that it is ready to
start formatting the photos when the Hashtag Monitor is run.
The first stage of the process is to use the Hashtag Monitor to download the photos and posting
information from Instagram.

Using Hotfolder Prints to format the photos

Hotfolder Prints can be setup to automatically format the photos downloaded by Hashtag Monitor. The
layout can be printed automatically or saved as a JPEG image for displaying in a slideshow or
touchscreen kiosk. The suggested Hotfolder Print settings for processing Instagram photos are shown
below:

http://www.breezesys.com/Hotfolder
http://www.breezesys.com/Hotfolder
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The "Folder to monitor for new images:" should be set to the folder where Hashtag Monitor downloads
the photos.

The number of images should be set to 2 to allow print layouts with both the photo and the author's
profile picture.

The "Processing mode:" must be set to "Wait for XML file" so that Hotfolder Prints can read the
posting information.

The "Filename prefix:" should be set to a value which gives unique filenames for the JPEG copy of the
printed output e.g. %d_%t_{user_id} which uses the date, time and user id to name the file.

It is recommended that the "Don't process files if output file already exists" option is selected. This will
allow the File->Rescan XML files option to be used without duplicate copies of the output files being
created. This is useful if Hotfolder Prints is run after Hashtag Monitor has downloaded the images.

Instagram photos are square and so the "Photo aspect ratio:" setting should be set to "1:1".

Next select the "Custom layout" option and click on the "Settings..." button to create the print layout.
The settings below show a layout for 6x4 prints made using a 300dpi dyesub printer:
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When designing an Instagram print layout image 1 represents the Instagram photo and image 2
represents the author's profile picture. The layout above also includes a QR code which can be
scanned by a smart phone to access a web page (this is covered in more detail latter).

Two captions are defined in the layout above. The first caption uses the {username}, {date} and {time}
tokens to print the author's username and that date and time the photo was posted. The tokens are
replaced with values for the photo being processed. The second caption uses the {caption} token to
display the photo's caption. Instagram captions can be very long and so the "Line word wrap" and
"Maximum number of lines" settings are used make sure the caption fits the page:

The following tokens can be used to in captions and QR codes:
{date} date the photo was posted on Instagram e.g. 2014/12/28
{time} time the photo was posted on Instagram e.g. 22:05:29
{photo}filename of the photo e.g. 162876187264876_87687656.jpg
{photo
_id}

id of the photo e.g. 162876187264876_87687656

{usern
ame}

author's Instagram username e.g. johndoe

{user_i
d}

author's Instagram user id e.g. 87687656

{captio
n}

photo caption e.g. Great party! #wedding20150115
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The example layout above includes a QR code which can be defined using a fixed URL (e.g. a link to
your website or your client's website) or a dynamically generated URL (e.g. a date based link a photo
gallery on your website or links to display the author's other photos on Instagram). Some example
URLs are given below:

URLs for QR codes to display the author's other Instagram photos:
https://instagram.com/{username}
http://websta.me/n/{username}
http://extragr.am/{username}
http://iconosquare.com/viewer.php#/user/{user_id}

URLs for QR codes to display a particular Instagram photo:
http://websta.me/p/{photo_id}
http://iconosquare.com/viewer.php#/detail/{photo_id}

Please note that Breeze System's Hotfolder Prints software is a separate product from Breeze Kiosk
and must be purchased separately.

Downloading Photos from Instagram using Hashtag Monitor

The main window below is displayed when Hashtag Monitor is run:

Enter the hashtag to monitor in the "Hashtag:" edit box and then specify the download folder where the
photos and caption information will be displayed. In the example above the hashtag to monitored is
#wppi2014 and the download folder is set to d:\instagram\{hashtag}. When downloading the photos the
token {hashtag} will automatically be replaced with the name of the hashtag being monitored - in the
example above the photos and caption information will be downloaded to d:\instagram\wppi2014.

Set the maximum age in hours for downloaded photos. Only photos with a creation time less than this
value will be downloaded.
If the maximum age is set to 0 all photos with the hashtag will be downloaded. Please take care
selecting the hashtag when setting this to 0 as a generic hashtag such as #sunset could result in a
very large number of photos being downloaded.

Normally the Hashtag Monitor will scan Instagram for photos matching the hashtag starting from the
most recent postings and will switch to idle mode if it reads a group of images that have already been
downloaded or are older than the maximum age setting. Set the "rescan" checkbox to override this
behavior and the Hashtag Monitor will scan the whole of Instagram for photos matching the hashtag
and age settings. It won't download photos that have already downloaded but this setting is useful if
new photos have been added since the last time it was run or some or allof the photos have been
deleted from the PC.

Press the "Log in" button to start the download process. This will open a window with the Instagram
login screen:

http://www.breezesys.com/Hotfolder
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Enter your Instagram username and password and click on the "Log in" button. If this is the first time
you have run Hashtag Monitor a screen will displayed asking you to approve the app's permissions.
Click "Yes" and Hashtag Monitor will start scanning Instagram for matching images:

.

Click on the window's close button to exit Hashtag Monitor.

Please note that Hashtag Monitor comes with Breeze System's Hotfolder Prints software which is a
separate product from Breeze Kiosk and must be purchased separately.

Display the Photos in Breeze Kiosk

Hotfolder Prints creates JPEG copies of the print layout in a subfolder named prints e.g. d:
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\instagram\wppi2014\prints in the example above. Breeze Kiosk should be setup to monitor this folder
e.g.

Click OK to save the settings and then click on the Run button to run Breeze Kiosk in full screen mode:

The user can scroll through the images and select them for printing, emailing or Tweeting. Hashtag
Monitor will look for new images posted to Instagram with the hashtag being monitored and will
automatically download them to the PC together with the author's profile picture and the caption
information. Hotfolder Prints will automatically format the downloaded photos and save a JPEG copy of
the print layout in the prints subfolder where they will be automatically added to the photos displayed in
Breeze Kiosk.

Hotfolder Prints, Hashtag Monitor and Breeze Kiosk can all run on the same computer if required.
Additional kiosks can be added by saving the files to a shared drive and connecting additional
computers, each running Breeze Kiosk, to the network. You only need one computer to download the
images using Hashtag Monitor and format them using Hotfolder Prints.



Tokens 69

© 2021 Breeze Systems Ltd

12 Tokens

The following tokens can be used in the thumbnail caption, email subject, email text and in text
messages.

General tokens

%a Abbreviated weekday name e.g. Fri

%A Full weekday name e.g. Friday

%b Abbreviated month name e.g. Jun

%B Full month name e.g. June

%d
Date in the form YYMMDD (equivalent to %y%m
%D)

e.g. 150617 for June 17,
2015

%D Day of the month (01 to 31)  

%H Hour (00 to 23)  

%I Hour (01 to 12)  

%j Day of the year (001 to 366)  

%l Long date/time representation of locale
e.g. Monday, January
17, 2015 19:03:47

%L Long date representation for locale
e.g. Monday, January
17, 2015

%m Month (01 to 12) e.g. 06 for June

%M Minutes (00 to 59)  

%p am/pm indicator e.g. PM

%S Seconds (00 to 59)  

%t
Time in the form HHMMSS (equivalent to %H%M
%S)

 

%W Week number (00 to 53)  

%x Date representation for locale
e.g. 06_17_15 for June
17, 2015

%X Time representation for locale e.g. 14_39_29

%y Year without century e.g. 11

%Y Year with century e.g. 2015

%z Time zone name
e.g. GMT Standard
Time

%Z Time zone offset wrt UTC
e.g. +0100 for GMT
during DST

{yearNow} Year 'now' in the form YYYY e.g. 2015

{monthNow} Month 'now' (01 to 12) e.g. 03 

{dayNow} Day 'now' (01 to 31) e.g. 05 

{yearLess8h}
Year with century 8 hours ago - useful when
shooting events which continue after midnight

e.g. 2015

{monthLess8h}
Month (01 to 12) 8 hours ago - useful when
shooting events which continue after midnight

e.g. 12

{dayLess8h}
Day of the month (01 to 31) 8 hours ago - useful
when shooting events which continue after
midnight

e.g. 31
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{filename}
The filename of the image without the file
extension or folder path

e.g. image1 for D:
\Photos\image1.jpg

{filename1},
{filename2} ...
{filename9}

Extracts a portion of the filename string delimited
by space, - or _

e.g. {filename2} gives
two for D:
\one_two_three.jpg

{fullFilename}
The filename of the image with the file extension
but without the folder path

e.g. image1.jpg for D:
\Photos\image1.jpg

{fileExt} The file extension
e.g. jpg for D:
\Photos\image1.jpg

{uid}
Extracts a UID in the form ABC12345 or
ABCDE123 from the filename or returns [UID not
found]

e.g.
20190621_HDTUW345.
jpg gives HDTUW345 

{subfolder} Extracts the name of the parent folder of the file
e.g. 20160718 for C:
\Photos\20160718
\IMG_0001.JPG

{eventName} The event name read from the event info

{eventString1} to
{eventString5}

Event strings read from the event info

{urlencode,str}
Encodes str so that it can be used as a parameter
in a URL e.g. when providing a URL for a
microsite

https://yoursite.com/view
er.php?id={urlencode,m
y name} gives
https://yoursite.com/view
er.php?id=my%20name

{hulaencode,str}
Converts str to lower case and replaces
characters which aren't letters or digits with - to
make it easier to link to galleries in Hula Gallery

John and Sue Wedding
gives
john-and-sue-wedding

Tokens for modifying strings

The tokens below can be used to modify tokens or strings:

Token Description Example

{left,n,str} Extracts the first n characters from str
(which can be a string or token). 

{left,4,{filename}} for D:\Photos\image1.jpg
will give: image

{mid,n,m,str
}

Extracts m characters starting from the n'th
character from str (which can be a string or
token). 

{mid,1,3,{filename}} for D:\Photos\image1.
jpg will give: mag
{mid,3,,{filename}} for D:\Photos\image1.jpg
will give: ge1

{right,n,str} Extracts the last n characters from str
(which can be a string or token). 

{right,2,{filename}} for D:\Photos\image1.jpg
will give: e1

{field,n,str} Extracts the nth field from str. Fields are
separated by space, period, comma,
hyphen or underscore characters

{field,2,{filename}} for D:
\Photos\one_two_three.jpg will give: two

{field2,n,ch,
str}

Extracts the nth field from str using the
character ch as the field separator

{field2,2,-,one-two-three} will give: two

{first,str} Extracts the first word from str (which can
be a string or token).

{first,%L} for an image taken Monday,
January 17, 2015 will give: Monday

{last,str} Extracts the last word from str (which can
be a string or token).

{last,%L} for an image taken Monday,
January 17, 2015 will give: 2015

{upper,str} Converts str to upper case {upper,%B} for a photo taken in June gives:
JUNE
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{lower,str} Converts str to lower case {lower,%B} for a photo taken in June gives:
june

{capitalize,s
tr}

Converts str to lower case and capitalizes
the first letter

{capitalize,john} gives John

{default,str1
,str2}

Returns str1 unless it is an empty string in
which case it returns str2 (str1 and str2 can
be strings or tokens

{default,1,2} returns 1
{default,,2} returns 2

{if,test,str1,
str2}

Returns str1 if test is not an empty string
else returns str2 (test, str1 and str2 can be
strings or tokens)

{if,1,2,3} returns 2
{if,,2,3} returns 3

{compare,st
r1,str2}

Returns 1 if str1 is the same as str2 else
returns an empty string

{compare,photo,photo} returns 1,
{compare,photo,image} returns empty string

{contains,st
r1,str2}

Returns 1 if str1 contains str2 else returns
an empty string

{contains,photo,to} returns 1,
{contains,photo,camera} returns empty string

13 Release History

15 December 2021: v2.1
· Added support for accepting payments using payment systems such as the Nayax VPOS Touch

contactless credit card reader
· Added the option to disable line drawing on prints so that users can only add emojis or stickers to

prints
· Improved support for printing a JPEG printer friendly copy of an image, GIF or MP4 file
· Added {field2,n,sep,str} token which allows the field separator to be specified
· Added {contains,str1,str2} token to test whether str1 contains str2
· Fixed an issue with username/password missing when emailing via GMail

5 June 2020: v2.0
· Added support for emailing via GMail using secure SMTP with OAuth2
· Added clipboard to allow multiple images to be selected and shared via email
· Added a startup screen which is displayed during the initial scanning of folders
· Add support for QR code inputs to send emails
· Added the filtering of photos
· Improved algorithm for caching thumbnails
· Fixed an issue which could cause a slideshow of MP4 videos to crash

12 November 2019: v1.6
· Added the option to sign or draw on photos, add emojis/stickers and frames
· Fixed a reliability issue with playing videos that was caused by recent Windows updates

25 June 2019: v1.5.2
· Added the option to sort images by timestamp
· Improved the sorting of images by filename when scanning subfolders
· Added {uid} token to extract a UID in the form ABC12345 or ABCDE123 from filenames
· Fixed an issue with the total prints. emails, texts and tweets counters not being updated
· Removed references to Facebook following changes made by Facebook in response to the

Cambridge Analytica scandal

29 May 2019: v1.5.1
· Added the option to play videos at least once when running a slideshow i.e. don't advance the

slideshow until the video has played from start to finish at least once
· Added the ability to print photos using different printer settings according to their filenames and to

double a single strip for printing on 6x4 dyesub printers
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· Added counters for the total number of prints, emails, texts and tweets
· Performance improvements for swiping images when running on Microsoft Surface Go
· Fixed an issue with the selected thumbnail changing when new images are added with the "Display

newest images first" option selected
· Fixed an issue which cold cause the wrong photo being printed if a new photo is added while the

print confirmation screen is displayed
· Fixed an issue setting the initial values of checkboxes in keyboards

28 November 2018: v1.5
· Added optional QR code display
· Added the option to print multiple copies as separate documents to increase throughput when using

printer pooling
· Emails can now include CC email addresses and the XML copy of the email can include additional

attachment information when sending MP4 files
· Much faster uploading of images when sharing by text or Twitter
· Fixed an issue where the wrong image could be emailed if a new image arrives when the email

address is being entered

14 April 2018: v1.4.4
· Fixed a problem with the software crashing on some systems when playing a slideshow of MP4

movie files
· Added "auto bleed" option when printing
· Adverts displayed in slideshow mode can now be JPEGs, animated GIFs or MP4 movie files
· Added the option to save XML copies of emails and texts

11 December 2017: v1.4.3
· Added controls for the size of the image cache held in memory to allow more images to be loaded

on computers with limited RAM
· Added event info shared via the Windows registry
· Fixed a problem with a blank frame being displayed initially for GIFs when running a slideshow

13 February 2017: v1.4.2
· Maintenance release which fixes a problem with a blank image being displayed in the slideshow

when a JPEG follows an animated GIF
· FBUploader.exe updated following Windows Updates that caused the previous user to remain

logged in to Facebook

10 January 2017: v1.4.1
· Added the option to ask for the user's email address before printing
· Improved the slideshow transitions for animated GIFs
· Fixed a problem with the option to choose which file types are displayed
· Fixed a problem with images not being deleted when using the scan subfolders option

1 December 2016: v1.4
· Added the option to scan subfolders for images
· Added the option to choose which file types are displayed
· Added the ability to post animated GIFs on Facebook
· Added the option to use "printer-friendly" images stored in the prints subfolder for printing and the

displayed images for sharing
· Fixed a problem with touchscreen operation when running on second display
· Fixed a problem with new images replacing the image being viewed full screen when using grid

mode
· Fixed a problem resending emails and texts containing MP4 video files when using offline mode
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5 July 2016: v1.3
· Added new grid layout display option which displays a grid of thumbnails and a full screen preview

with icons for printing etc. when the user selects a thumbnail
· Added support for MP4 movie files
· Added privacy mode where images are only displayed if the user enters the correct code
· Added a  mode when printing
· Added the option to automatically select and display new files when they are added to the folder

being monitored
· Added stable time setting for more reliable operation when accessing images across a network

when the computer clocks are not synchronized
· Max percentage scaling option added to allow small photos or videos to be enlarged when they are

displayed

15 December 2015: v1.2.1
· Added keyboard shortcuts and information on how to run a kiosk without a touchscreen
· Fixed a problem with image attachments not displaying in emails sent to Outlook.com
· Replaced %1, %2, %3, %4, %5, %6 tokens with {yearNow}, {monthNow}, {dayNow}, {yearLess8h},

{monthLess8h}, {dayLess8h} to avoid problems with unwanted substitutions in emails and texts
· Fixed a typo in the default text for HTML emails: correcting <image src="{image}"> to <img

src="{image}">

2 December 2015: v1.2
· Added support for animated GIFs
· Added Twitter upload option
· Added MMS and SMS texting via Twilio complete with offline option and the ability to send the

messages later
· Added option to send emails and post to Facebook using a URL instead of attaching the image
· Added the ability to allow users to choose the number of copies to print
· Photos are now removed from display if they are deleted from the folder being monitored

28 August 2015: v1.1
· SMS text option (using email to SMS services)
· Slideshow now has the option to display adverts
· Thumbnail and slideshow images can now be cropped independently of the main images
· Settings can now be saved to and loaded from file
· Added the option to limit the number of prints
· Added offline mode for emails
· Added the option to show the mouse cursor to allow mouse operation without a touchscreen
· Added the option to display the most recent images first

29 January 2015: v1.0
· First public release
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